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ABOUT THIS GUIDE

This document provides information for implementing a Fault Tolerant Ethernet supervisory network
between Experion Servers and C200/C300 Controllers through the Fault Tolerant Ethernet Bridge
module. It includes module installation, configuration, operation, and service data.

Revision Date Description

A November 2019 Initial release of the document.
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INTRODUCTION

l Overview

l Getting Started

l Conventions

2.1 Overview

The Experion system supports supervisory level communications over Honeywell's Fault Tolerant
Ethernet (FTE) network using the Fault Tolerant Ethernet Bridge module. It also supports supervisory
level communications over a ControlNet network or Ethernet network using a ControlNet Interface
(CNI) module or Ethernet module, respectively.

ATTENTION

You cannot mix the supervisory network types on an Experion Server or Station. For example, If
your Server is currently using a ControlNet supervisory network, you cannot add a Fault Tolerant
Ethernet supervisory network to the Server for simultaneous communication with different
controllers. Of course, you can replace the ControlNet network with a FTE network, if desired.

Since Fault Tolerant Ethernet technology provides a highly available networking scheme using
commercial network interface cards (NIC) and Ethernet switches, the preferred supervisory network
type is Fault Tolerant Ethernet.

For more information about Honeywell's Fault Tolerant Ethernet, refer to the Fault Tolerant Ethernet
Overview and Implementation Guide.

l Functional Overview and Guidelines

2.1.1 Functional Overview and Guidelines

The following figure shows a basic Experion system topology with C200 Controller using a Fault
Tolerant Ethernet supervisory network. The Experion system still provides the same configuration,
control, and monitor functions as it does with a ControlNet supervisory network. However, the following
guidelines are unique to Fault Tolerant Ethernet supervisory networks.

l Each FTE Bridge module must be assigned a unique Device Index.

l The same Experion Server cannot support simultaneous ControlNet or Ethernet and Fault Tolerant
Ethernet communications to different C200 Process Controllers (also known as C200 Controllers).
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l Must use a downlink ControlNet interface module to support remote I/O over a ControlNet segment.

l The Fault Tolerant Ethernet Bridge module provides 10 megabits per second (Mbps) Ethernet
connectivity. All Ethernet switches must be 10/100 Mbps with a minimum 1 gigabits per second fast
backplane to minimize latency.

Beginning with Experion R300, the C300 Controller will reside on the same FTE network as the FTE
Bridge module and support C300 to C200 peer-to-peer communications. The C300 can communicate
directly with Series A - Chassis I/O through a FTE Bridge module mounted in the I/O chassis, as shown
in the following figure. A C300 can also communicate with ControlNet resident devices, like
Programmable Logic Controllers (PLC), and so on, through a FTE Bridge module mounted in a chassis
with a ControlNet Interface module (CNI) or Ethernet module.

- 8 -
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Chapter 2 - Introduction

2.2 Getting Started

Before getting started, you must perform the following:

l Install Experion software

l Install FTE supervisory network

l Determine wiring requirements

l Enure to have a knowledge of all the assumptions

l Installing Experion Software

l Installing FTE supervisory network

l Determining wiring requirements

l Assumptions

2.2.1 Installing Experion Software

Refer to the Software Installation and Upgrade Guide for details about installing the Experion software.
The Fault Tolerant Ethernet Bridge is compatible with Experion software release R200 or greater.

2.2.2 Installing FTE supervisory network

Refer to:

l Fault Tolerant Ethernet Installation and Service Guide for details about installing Fault Tolerant
Ethernet as the supervisory network.

l Fault Tolerant Ethernet Overview and Implementation Guide for general information about
implementing a FTE network.

2.2.3 Determining wiring requirements

You will need category 5 shielded twisted pair cable with 100 ohm impedance and electrical
characteristics supporting transmission rates of up to 100 Mbps to connect the Fault Tolerant Ethernet
Bridge and NIC to switch ports. The cable must be compliant with the TIA/EIA-568A wiring standard as
well as the 100BaseTX IEE-802.3u specification. Ensure the cable is appropriate for your planned
routing method and meets both national and local electrical and fire codes.

Refer to the Fault Tolerant Ethernet (FTE) Specification and Technical Data EP03-500-200 for details
about FTE cable usage and available Honeywell pre-configured cables.

If you have access to the internet, you can visit the Belden Wire and Cable Company web site at
http://www.belden.com/ for helpful technical data on a wide variety of wire and cable types.

2.2.4 Assumptions

The current software release is running on your Experion Server and all applicable FTE nodes. This
includes the FTE driver and the BOOTP Server service.

The reader must have knowledge about Ethernet and the Transmission Control Protocol/Internet
Protocol (TCP/IP).

For more information about TCP/IP and internet working, refer to:
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l Internet working with TCP/IP - Vol. 1, 2nd ed., by Douglas E Comer (ISBN 0-13-216987-8)

l The Ethernet Management Guide - Keeping The Link (ISB 0-07-046320-4)

l An Introduction to TCP/IP (ISBN 3-540-96651-X)

l Computer Networks by Andrew S. Tanenbaum (ISBN 0-13-162959-X)

2.3 Conventions

The following table summarizes the terms and type representation conventions used in this Guide.

Term/Type
Representation

Meaning Example

click Click left mouse button once. (Assumes cursor is
positioned on object or selection.)

Click the Browse
button.

double-click Click left mouse button twice in quick succession.
(Assumes cursor is positioned on object or
selection.)

Double click the
Station icon.

drag Press and hold the left mouse button while dragging
cursor to new screen location and then release the
button. (Assumes cursor is positioned on object or
selection to bemoved.)

Drag the PID
function block
onto the Control
Drawing.

right-click Click right mouse button once. (Assumes cursor is
positioned on object or selection.)

Right-click the
AND function
block.

<F1> Keys to be pressed are shown in angle brackets. Press <F1> to
view the online
Help.

<Ctrl>+<C> Keys to be pressed together are shownwith a plus
sign.

Press
<Ctrl>+<C> to
close the
window.

File->New Showsmenu selection asmenu name followed by
menu selection.

Click File->New
to start new
drawing.

>D:\setup.exe< Data to be keyed in at prompt or in an entry field. Key in this path
location
>D:\setup.exe<.
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INSTALLATION

l About FTE Bridge Module

3.1 About FTE Bridge Module

ATTENTION

Ensure you review the pre-installation considerations and approval body notifications included
in the Control Hardware Installation Guide before you install any Experion system component.

Electrostatic discharge can damage integrated circuits or semiconductors if you touch backpanel
connector pins. Follow these guidelines when you handle a module:

l Touch a grounded object to discharge static potential

l Wear an approved wrist-strap grounding device

l Do not touch the backpanel connector or connector pins

l Do not touch circuit components inside the module

l If available, use a static safe workstation

l When not in use, keep the module in its static shield box or bag

l Setting unique Device Index

l Checking cable shield ground jumper

l About MAC addresses

l Installing FTE Bridge module (TC-FTEB01/TK-FTEB01)

l Attaching FTE cables

3.1.1 Setting unique Device Index

To set a unique Device Index for the Fault Tolerant Ethernet Bridge module
before it is installed

- 11 -
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1. If applicable, remove the FTE Bridge module from its shipping container.

2. Locate the pair of binary-coded decimal rotary switches on the top of the module.

ATTENTION

If the FTE Bridge module is being installed in a redundant chassis pair (RCP), ensure to
set the Device Index for the FTE Bridge module to be installed in the Primary chassis to
be an odd number. Then, set the Device Index for the FTE Bridge module to be installed
in the Secondary chassis to be the next higher even number.

For example, if you set the Device Index to 17 for the Primary FTE Bridge module, you
would set the Device Index for the Secondary FTE Bridge module to 18.

3. Viewing the top of the switches, use your fingers to set the left-hand switch to the desired most
significant decimal number and the right-hand switch to the desired least significant decimal
number. The applicable setting range is 01 to 99. For example, to set a Device Index equal to "18";
set the left switch to "1" and right one to "8".

4. If applicable, repeat this procedure to set the Device Index for the Secondary FTE Bridge module
for a redundant chassis pair configuration.

3.1.2 Checking cable shield ground jumper

Prerequisites

l The shield for the shielded twisted pair cable must be connected to ground at only one end. Ensure
the cable shield ground jumper on the FTE Bridge module is positioned correctly to either ground
the pair of cables to the chassis or isolate them from the chassis.

l Ensure the chassis is grounded as outlined in the Control Hardware Installation Guide.

- 12 -
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To check or set the ground jumper for the port A cable (yellow) and port B
cable (green)

1. Open the front door on the FTE Bridge module.

2. Locate the hardware jumpers designated as SHIELD A and SHIELD B.

3. To ground the shield on the FTE A link cable end connected to the FTE Bridge module to the
chassis, install the jumper across the pins for SHIELD A.

4. To let the shield on the FTE A link cable end connected to the FTE Bridge module "float" (or not be
connected to any source of electrical potential), remove the jumper from across the pins for
SHIELD A.

TIP

To remove the jumper and keep it handy for future use, just put it on one jumper pin.

5. To ground the shield on the FTE B link cable end connected to the FTE Bridge module to the
chassis, install the jumper across the pins for SHIELD B.

6. To let the shield on the FTE B link cable end connected to the FTE Bridge module "float" (or not be
connected to any source of electrical potential), remove the jumper from across the pins for
SHIELD B.

7. If applicable, repeat this procedure for the other FTE Bridge module in a redundant chassis pair
(RCP).

3.1.3 About MAC addresses

Every FTE Bridge module comes with factory assigned media access control (MAC) addresses for both
FTE links. The FTE B link MAC address equals the FTE A link MAC address plus one. The assigned
MAC addresses are recorded on a label on the door of the FTE Bridge module.
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3.1.4 Installing FTE Bridge module (TC-FTEB01/TK-FTEB01)

ATTENTION

The following procedure assumes that the chassis has been installed and grounded as outlined
in the Control Hardware Installation Guide, and power is not applied.

To insert the FTE Bridge module into the chassis

1. Align the module's circuit board with the top and bottom chassis guides for the planned slot
location. Typically, slot 0 is reserved for the communication module. (Remember that slot
numbering is zero-based and the left most slot is number "0".)

- 14 -
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Chapter 3 - Installation

2. Slide the module into the chassis, until the module's locking tabs "click" into position. The module is
fully installed when it is flush with the power supply or other installed modules.

3. Repeat Steps 1 and 2 to install other modules, as required.

4. Go to the next Section Attaching FTE cables.

3.1.5 Attaching FTE cables

ATTENTION

Unless the location is known to be non-hazardous, do not:

l Connect or disconnect cables

l Install or remove modules while the Control system is powered.

The FTE Bridge module includes two RJ-45 modular jacks located behind its front door. They provide
redundant Ethernet media connections for FTE ports A and B. The dust boots on the cables are color
coded yellow for port A and green for port B. The following figure shows the pin out for the 8-pin RJ-45
connector.
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To connect the FTE port A and port B cables to the FTE Bridge module

1. Open the module's door and plug the FTE A Link cable RJ-45 plug with yellow dust boot into the
bottom port A jack, so it locks into place.

2. Plug the FTE B Link cable RJ-45 plug with green dust boot into the top port B jack, so it locks into
place.

3. Dress cables so they exit the bottom of the module and close the front door.

4. Connect the other end of the cable to the Ethernet switch port. Ensure to make all Supervisory FTE
network connections.

- 16 -
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CONFIGURATION

l Things to consider before configuring FTE bridge

l Configuring FTE Bridge

4.1 Things to consider before configuring FTE bridge

This section provides the following considerations for configuring FTE bridge.

l Address configuration considerations

l Other configuration considerations

l I/O memory usage considerations

l Address configuration considerations

l Other configuration considerations

l I/O memory usage considerations

4.1.1 Address configuration considerations

The following table provides an overview of things you must consider for the listed IP address
assignment.

Address Assignment Default Considerations

Base IP Address 10.0.0.0

l The first number in the address represents
the network number

l Refer to the Fault Tolerant Ethernet
Overview and Implementation
Guide for more information about IP
addressing.
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Address Assignment Default Considerations

l The second number in the address
represents the community number.

l The third number can be user defined.

l The last number represents the embedded
node's Device Index.

l The default value for the last number
must be 0.

l The BOOTP server dynamically
assigns the FTE Bridgemodules IP
address by incrementing the last two
numbers to equal the unique Device
Index setting for themodule. For
example, if the configured base IP
address is 10.100.0.0 and the FTE
Bridgemodule's Device Index is 89,
the BOOTP server dynamically
assigns 10.100.0.89 as the FTE
Bridgemodule's IP address. If the
configured base IP address is
172.20.0.0 and the FTE Bridge
Module's Device Index is 1, the
BOOTP server dynamically assigns
172.20.0.1 as the FTE Bridge
module's IP address. See Setting
unique Device Index in this
document for details.

Subnet Mask 255.255.0.0 The Subnet Maskmaps FTE communities into
Ethernet subnets.

Refer to the Fault Tolerant Ethernet Overview and
Implementation Guide for more information about
IP addressing.

Routers use subnets to filter messages, the router
ignoresmessageswithin a port's subnet, and
messages to other subnets are forwarded to the
appropriate port.

The subnet mask configured within a Control
Builder System Preferences dialog applies only
to the embedded nodes (FTE Bridgemodules)
communicating with that Server's BOOTP service.

The subnet mask can be used within an FTE
community to enhance the security of embedded

- 18 -
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Address Assignment Default Considerations

nodes.

There are a number of websites that providemore
information about subnet masks and how tomake
subnet calculations. For example, the
subnetonline.com site
http://www.subnetonline.com/index.html provides
access to online calculators.

Default Gateway 0.0.0.0 Use a default gateway to facilitate
communications between nodes residing on
different networkswith different network numbers.

Do not change the default value (0.0.0.0) unless
instructed to do so by network services.

Refer to the Fault Tolerant Ethernet Overview and
Implementation Guide for more information about
IP addressing.

The default gatewaymust be set to the IP address
of the router that connects the two networks.
Given the example shown below, "Node A" and
"Node B" could not communicate with each other
without the default gateway defined. The default
gateway for "Node A" would be the IP address of
the port it connects to at its router - 10.1.250.0; the
default gateway for "Node B" would be
172.16.250.0, which is the IP address for its router
port.

4.1.2 Other configuration considerations

The following table summarizes other things you must consider before configuring the FTE Bridge
module.

What you must consider And, why

Do not include other Avoid conflicts in address assignments.
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What you must consider And, why

BOOTP servers on
network other than
Honeywell BOOTP
servers bundled with
Experion software.

Dynamic Host
Configuration Protocol
(DHCP) server

If DHCP server is present, ensure it is configured not to
respond to BOOTP request to avoid incorrect address
range assignments.

Non-Embedded Node IP
Address Assignment

Only embedded FTE nodes (FTE Bridgemodule) receive
IP addresses from the BOOTP server based upon the Base
IP Address and their Device Index.

Refer to the Fault Tolerant Ethernet Overview and
Implementation Guide for more information about IP
addressing.

Multiple Clusters within
One FTE Community

You can havemultiple Server clusters within one FTE
Community and configure up to 200 nodes, including 99
physical FTE Bridgemoduleswithin one community.

BOOTP Support The Honeywell enhanced BOOTP protocol provides
automatic, consistent IP Address assignment for FTE
Bridgemodules based upon the Base IP Address and their
Device Index. It allows address assignment to both FTE
links. It also provides a way to identify FTE modules by type
and several other enhancements. The FTE Bridgemodule
implements all features of Honeywell enhanced BOOTP
protocol, but it does not expose theMAC addresses to the
user.

Duplicate Address
Detection

The FTE Bridgemodule is designed to gracefully join the
FTE network duringmodule startup. It first determines if any
other module uses the same IP address; and, in case of
address conflict, it does not join a network but instead
transitions to "no address" state waiting for a new address
assignment.

FTE Bridgemodule as
RSLinx-Like Driver

The FTE Bridgemodule acts like an RSLinx-like driver for
Control Data Access and Control Builder. The driver name
is FTEBmodule tag. Once you add the FTE BridgeModule
block to Control Builder, it is added to the internal list of
drivers.

Control Processor Module
(CPM), Fieldbus Interface
Module (FIM), and I/O Link
Module (IOLIM)

Once you configure the FTE Bridgemodule block in Control
Builder, you can configure CPM, FIM, and IOLIM on the
FTE by selecting FTEB as the RSLinx-like driver.

- 20 -
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What you must consider And, why

Configuration on FTE.

Series A I/OModule
Configuration on FTE with
C200

There is no change in I/Omodule configuration for FTE
supervisory network, since the way the CPMaccesses I/O
data is unchanged.

Series A I/OModule
Configuration on FTE with
C300

When you assign a Series A - Chassis I/Omodule to a
C300 block in Control Builder, youmust configure the name
of the FTE Bridge block that represents the FTEBmounted
in the Series A I/O chassis to identify the communications
path to the IOMon its configuration form. The following
illustration shows an excerpt of the FTE Bridge Name field
that appears on the IOM's configuration formwhen the IOM
is assigned to a C300 block.

For details of the FTEB Reference parameter, see its description in the Control Builder Parameter
Reference at FTEBBLOCK.

4.1.3 I/O memory usage considerations

When the C200 Controller or the FTE Bridge module with C300 Controller makes a connection with a
Chassis Series A, or Series A or H rail I/O Module (IOM), the module allocates I/O buffer memory to
support the I/O connection data exchange. The C200 Controller and the FTE Bridge module each have
total I/O buffer limits and each IOM has I/O buffer size requirements. The sum of all IOM buffers
required/configured must be less than the C200 Controller or FTE Bridge module total available. It is
unlikely that you will encounter this limitation unless you are using a Serial Interface Module (SIM),
Profibus, or DeviceNet interface with your system as well.

Available I/O memory and the required memory per module

The following table lists the available I/O memory and the required memory per module type for
reference.

Available I/O Buffer Memory Capacity

Controller or I/O Gateway
Module

I/O Memory
Available

Controller or I/O Gateway
Module
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Available I/O Buffer Memory Capacity

1 C200 CPM 18564 bytes 1 C200 CPM

1 FTEBModule (when used
with C300)

8096 bytes 1 FTEBModule (when used
with C300)

I/O Buffer Memory Table

Chassis Series A I/O
Modules 1

Rockwell I/O
Modules

I/O Memory Required per
Module (bytes)

TC_IAH061 1756-IF6I 152

TC_IAH161 1756-IF16 200

TC_IDA161 1756-IA16 132

TC_IDD321 1756-IB32/B 132

TC_IDJ161 1756-IB16I 132

TC_IDK161 1756-IA16I 132

TC_IDW161 1756-IM16I 132

TC_IDX081 1756-IA8D 144

TC_IDX161 1756-IB16D 144

TC_IXL061 1756-IT6I 152

TC_IXL062 1756-IT6I2 152

TC_IXR061 1756-IR6I 152

TC_OAH061 1756-OF6CI 180

TC_OAV061 1756-OF6VI 180

TC_OAV081 1756-OF8 196

TC_ODA161 1756-OB16I 136

TC_ODD321 1756-OB32 136

TC_ODJ161 1756-OB16I 136

TC_ODK161 1756-OA16I 136

TC_ODX081 1756-OA8D 152

TC_ODX161 1756-OB16D 152
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I/O Buffer Memory Table

TC_ORC081 1756-OX8I 136

TC_ORC161 1756-OW16I 136

Serial InterfaceModule 732 + (1 to 7 additional
connections) * 732

DeviceNet - DNET_IM 364 + output data size + input
data size

Profibus - PBIM_SST 600 + output data size + input
data size

Series A Rail I/O
Modules 1

I/O Memory Required per
Module (bytes)

TC_FIAH81 1794-IE8 136

TC_FID161 1794-IB16 132

TC_FIDA81 1794-IA8 132

TC_FIL081 1794-IT8 140

TC_FIR081 1794-IR8 140

TC_FOA041 1794-OE4 140

TC_FOD161 1794-OB16P 128

TC_FODA81 1794-OA8 128

TC_FOR081 1794-OW8 128

Series H Rail I/O
Modules 1

I/O Memory Required per
Module (bytes)

TC_PIA082 140

TC_PIB161 120

TC_PIL081 136

TC_POA081 160

TC_POB041 132

1 TheC300 with FTE Bridgemodule only supports the following chassis-based
Modules:

l Serial InterfaceModule
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I/O Buffer Memory Table

l DeviceNet - DNET_IM

l Profibus - PBIM_SST

l Pulse Input

4.2 Configuring FTE Bridge

ATTENTION

The procedures in this section assume that you:

l Have installed the Experion release R300 software and have the Control Builder
application running. If you have not installed the Experion software, refer to the Software
Installation and Upgrade Guide for details. If you have not launched Control Builder,
refer to the Control Building Guide for details.

l Have installed and configured your Fault Tolerant Ethernet network. If you have not
installed the FTE network, refer to the Fault Tolerant Ethernet Overview and
Implementation Guide, and setup your FTE supervisory network before continuing with
this procedure.

l Are making initial IP address settings before any FTE Bridge module has been
configured or powered up.

l Are configuring the components on a Server connected to the FTE supervisory network.
If you are configuring the components offline on a Station or computer that is connected
to another network, be careful when entering the IP addresses.

l Setting up addresses

l Checking status of BOOTP server service

l Creating FTE bridge module block

l Loading FTE bridge block

4.2.1 Setting up addresses

The procedure to check the base IP address, subnet mask, and default gateway settings is found in the
System Preferences section of the Control Building User's Guide.

4.2.2 Checking status of BOOTP server service

TIP
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If BP is being displayed on the module's front-panel display and the BOOTP Server service is
already running, try stopping and re-starting the service to re-establish the correction after FTE is
configured correctly.

To confirm that the BOOTP Server service is running

1. On the taskbar, click the Start button, and then click Settings > Control Panel.

Opens the Control Panel window.

2. Double-click the Administrative Tools icon.

Opens the Administrative Tools window.

3. Double-click the Services icon.

Opens the Services window.

4. In the vertical scroll bar, use the scroll box to scroll items in the open window to find the Experion
BOOTP Server service.

Confirm that Started is listed in the Status column for the service.

5. If:

l Started is listed, go to Step 9.

l If Status column is blank, go to Step 6.

6. Double-click the Experion BOOTP Server icon.

Opens the Experion BOOTP Server Properties dialog.
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TIP

If the Start button is unavailable, the BOOTP Server service is started. If the Stop button
is unavailable, the BOOTP Server service is stopped, You can use these buttons to stop
and start the BOOTP service, as required.

7. Click the Start button.

Initiates service start function and opens the Service Control dialog to track progress.

8. After the Service Control dialog closes, check that the Service status is Started and the Start button
is unavailable.

Confirm that service has started.

9. Click the OK button.

Closes Experion BOOTP Server Properties dialog.

10. Click the Close button .

Closes Services window.

11. Click the Close button .

Closes Administrative Tools window.

12. This completes the procedure.

Go to the next section.
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4.2.3 Creating FTE bridge module block

ATTENTION

l You must create the FTE Bridge module function block before creating blocks for Control
Processor Module (CPM), Fieldbus Interface Module (FIM), and I/O Link Interface Module
(IOLIM), so you can specify the FTE Bridge block name as the Driver Name on the
configuration forms for the latter blocks.

l Also, you must create the FTE Bridge module function block in Control Builder before
you can view it in the Network Tools (NTools) utility.

Use the following procedure to create a tagged function block to represent the installed FTE Bridge
module. This procedure assumes that you have configured a valid base IP address through the
Embedded FTE tab on the System Preferences dialog. See the previous Setting up addresses
procedure. You cannot create a FTE Bridge module block with an invalid address (0.0.0.0).

To create FTE bridge module

1. In Control Builder, click the File menu, and then choose New > Interface Modules > FTEB-FTE
Bridge Module.

Opens SYSTEM:FTEB Block, FTEB_XX- Parameters [Project] configuration form. Where XX
equals a system assigned unique number.

TIP

The block name can be up to 16 characters long and must contain at least one letter (A-
Z). It must not contain an embedded space or leading space, and dots are allowed in
parameter naming only.

2. Type the desired block name in the Name box or accept the assigned name. The Unique name
identifies the component within Control Builder views and Station displays. Press the TAB key.

Moves cursor to Associated Asset box.

3. Click the button to the right of the Associated Asset box.

The Point Selection dialog box appears.

4. Select an asset from those configured in the Enterprise Model Database to set the Scope of
Responsibility (SOR) for the point.

ATTENTION

No validation is done at the configuration time. If you enter an asset that does not exist
in the points database, the associated asset for the point reverts to the server point. If
the asset does exist but is not an area-enabled asset, then the first area-enabled asset
up the tree is used for the SOR of that device. A subsequent upload of that device point
to Control Builder returns the area-enabled asset and not the original non-assignable
asset entered.

Moves cursor to Device Index box.
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5. Type the Device Index number that matches the one set on BCD rotary switches of the FTE Bridge
module that this block represents. Press the TAB key.

Moves cursor to Module Slot Number box.

6. Click the arrow and select the number of the chassis slot where the physical FTE Bridge module is
installed. Press the TAB key. (Remember that chassis slot numbering is zero based, so the first slot
on the left is number "0".)

Moves cursor to This module is redundant check box.

TIP

After you select the Module Slot Number, the IP Address is updated to match the IP
address previously configured through the System Preferences dialog plus the Device
Index number you just entered in Step 3. For example, if the IP Address is 10.10.0.0
and you configured a Device Index of 85, the assigned IP Address would be
10.10.0.85.

7. Perform any of the following:

l If the FTE Bridge module is installed in a non-redundant C200 Controller or Fieldbus Interface
Module (FIM) chassis, leave the This module is redundant check box blank.

Opens Server History tab. Go to Step 8.

l If the FTE Bridge module is one of a pair of modules installed in a redundant C200 Controller
or FIM chassis, click the This module is redundant check box to select it. Press the TAB key

Moves cursor to Secondary Name box. Go to Step 6.

8. Type the desired secondary block name in the Secondary Name box or accept the default, which is
the name entered in Step 2 with a suffix of "SEC". Click the Server History tab.

Opens the Server History tab.

9. Use the online help to fill in the applicable data on the Server History tab. Click the Server Displays
tab.

Opens the Server Displays tab.

ATTENTION

If you are using a distributed Server architecture and/or Areas is enabled in Station, you
must enter an assigned area name in the Control Area box.

10. Use the online help to fill in the applicable data on the Server Displays tab. Click the Control
Confirmation tab.

Opens the Control Confirmation tab.

11. Use the online help to fill in the applicable data on the Control Confirmation tab. You must have a
license for the Electronic Signature option to use this tab. Click the Identification tab.

Opens the Identification tab.

12. Use the online help to fill in the applicable data on the Identification tab. Click the OK button.

Closes the SYSTEM:FTEB Block, FTEB_XX- Parameters [Project] configuration form and creates
FTE Bridge block icon in Project tab.
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TIP

You can only view FTE Bridge Blocks in Project tab set for the Assignment view. The
Assignment view shows the relationship among all blocks while the Containment view
only shows templates that contain other templates or Control Modules (CM), Sequential
Control Modules, (SCM) and basic blocks. To toggle the view, right-click in an open
area of the tab window and select Assignment View or Containment View from the
shortcut menu, as applicable.

13. Is this a redundant FTE Bridge module configuration?

l If the answer is Yes, go to the next Step.

l If the answer is No, go to Step 18.

14. In the Project tab, double-click the Secondary FTE Bridge block icon.

Opens the SYSTEM:FTEB Block, FTEB_XXSEC- Parameters [Project] configuration form.

TIP

The configuration information on the Main tab for the secondary FTE Bridge block
reflects the data entered on the Main tab for the primary FTE Bridge block. Check that
the IP address is the same except for the device index component that is incremented
by 1, and the module slot location is the same. This information is view only. You can
change the name of the block, if desired.

15. Type the desired block name in the Name box or accept the assigned name. The Unique name
identifies the component within Control Builder views and Station displays. Click the Server History
tab.

Opens the Server History tab.
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16. Use the online help to fill in the applicable data on the Server History tab. Click the Server Displays
tab.

Opens the Server Displays tab.

ATTENTION

If you are using a distributed Server architecture and/or Areas is enabled in Station, you
must enter an assigned area name in the Control Area box.

17. Use the online help to fill in the applicable data on the Server Displays tab. Click the Control
Confirmation tab.

Opens the Control Confirmation tab.

18. Use the online help to fill in the applicable data on the Control Confirmation tab. You must have a
license for the Electronic Signature option to use this tab. Click the Identification tab.

Opens the Identification tab.

19. Use the online help to fill in the applicable data on the Identification tab. Click the OK button.

Closes the SYSTEM:FTEB Block, FTEB_XXSEC- Parameters [Project] configuration form.

20. This completes the configuration procedure.

You can now load the FTE Bridge Block to the FTE Bridge module.

4.2.4 Loading FTE bridge block

With the FTE network installed, you load the FTE Bridge block through Control Builder as you would
any other block. Use the following procedure as a guide.

TIP

l The FTE Bridge module must be installed and powered before you can load data to it.
See the Operation section for details on Applying power to FTE Bridge Module.

l If you have a Qualification and Version Control System (QVCS) license, you can use
the relaxed loading function to load a block without checking it in to QVCS. Once you
check a block into QVCS, it is subject to the QVCS load requirements.

To load FTE bridge block

1. In the Project tab, click the FTE Bridge block icon.

Selects the block you want to load.

2. In the Controller menu, click Load.

Opens Load Dialog.
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TIP

You can right-click the FTE Bridge block icon and select Load from the shortcut menu or

just click the Load button in the toolbar with the block selected, as alternate
methods to open the Load Dialog.

3. Ensure the Load check box is selected. Click the OK button.

Initiates the load operation and opens the Load dialog to show the progress of the load as well as
display any load detected errors.

4. When load completes, click the Monitoring tab.

Opens Monitoring tab.

5. Confirm that FTE Bridge block icon now appears. See the following table Viewing FTE Bridge icon
in Monitoring tab to determine the status of the module from the color coded icon.

Confirm block is loaded and status of associated module.

6. Repeat this procedure to load another FTE Bridge block, if required.

Load all FTE Bridge blocks including secondary FTE Bridge block for redundant pair.

7. This completes the procedure.

Go to the next section.

See the Control Building Guide for more information about loading control strategy components.

Viewing FTE Bridge icon in Monitoring tab

If Icon for Non-Redundant FTE
Bridge block Is . . . Then, Module Status Is . . .

Green
Control Data Access (CDA) server can
communicate with themodule.

Red
CDA server cannot communicate with the
module.
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If Icon for
Redundant Primary
FTE Bridge Block
Is . . . Then, Module Status Is . . .

Green and
Secondary isWhite

Module pairs are synchronized and CDA server can
communicate with the primarymodule.

Green and
Secondary is Yellow

Module pairs are not synchronized but secondary
partner is visible and synchronization is in progress.
CDA server can communicate with primarymodule.

Green and
Secondary is

transparent

Module pairs are not synchronized and secondary
partner is not visible. CDA server can communicate with
primarymodule.

Red and Secondary

isWhite

CDA server cannot communicate with the primary
module.

If Icon for Redundant
Secondary FTE
Bridge Block Is . . . Then, Module Status Is . . .

Green and Primary

isWhite

Module pairs are synchronized and CDA server can
communicate with the secondarymodule.

Green and Primary

is Yellow

Module pairs are not synchronized but primary partner
is visible and synchronization is in progress. CDA
server can communicate with secondarymodule.

Green and Primary

is Transparent

Module pairs are not synchronized and primary partner
is not visible. CDA server can communicate with
secondarymodule.

Red and Primary is

White

CDA server cannot communicate with the secondary
module.
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OPERATION

l Starting and Monitoring FTE Bridge Module

l Using Control Builder Interface

l Using Network Tools (NTools) Utility

l Using Station Displays

l FTE Bridge Redundancy Operation Considerations

5.1 Starting and Monitoring FTE Bridge Module

l Applying power to FTE Bridge Module

l Monitoring front-panel display

l Monitoring front-panel LEDs

5.1.1 Applying power to FTE Bridge Module

The chassis-mounted FTE Bridge Module receives its power from the chassis power supply. You cycle
power to the module by turning the power supply switch On and Off. The following table lists some
common power application scenarios that you must consider before powering up the FTE Bridge
Module for the first time.

If you are applying
power Then, Consider this

For the first time. The FTE Bridgemodule requests an IP address from the
BOOTP Server. The BOOTP Server respondswith an IP
address that is based upon the base IP address configured in
Control Builder and the Device Index setting for the FTE
Bridgemodule. See Setting up addresses and Setting unique
Device Index for details. This is considered a cold start.

Subsequent to the
initial power up as part
of normal chassis
power cycling.

The FTE Bridgemodule does not request an IP address from
the BOOTP Server. This is considered a warm start.

After changing the
Device Index on the
FTE Bridgemodule or

Youmust make corresponding configuration changes for the
FTE Bridge block in Control Builder. See Creating FTE Bridge
module block for more details.
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If you are applying
power Then, Consider this

moving the FTE
Bridgemodule to a
different slot in the
chassis.

This is like applying power for the first time or a cold start. See
the first row above.

5.1.2 Monitoring front-panel display

The FTE Bridge module front panel includes a 4-character, alpha-numeric display to show the status of
the module. During normal operation, the display alternates between showing its Device Index and
current state. The following table lists possible state indications and gives a brief explanation of their
meaning.

Possible Display Indications

If Display Indication
Is . . .

Then, It Means . . .

OK The FTE Bridgemodule is running application code and is
functioning properly.

FAIL Application has crashed. Alternateswith crash code display.

ALIV Executing boot code, no application image is loaded. See
Loading Personality image.

RDY Module is ready for firmware download. See Loading Boot code.

BP Requesting IP address through BOOTP Server.

BOOT Boot is in progress and self-test is being run.

WDTd Watchdog timer diagnostics.

TXXX Performing startup test number XXX (see FTEB test codes).
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If Display Indication
Is . . .

Then, It Means . . .

PASS Passed all startup tests.

BKUP Module is functioning as secondary in redundant pair.

#0XX XX is the Device Index number setting for themodule.

5.1.3 Monitoring front-panel LEDs

Possible LED Indications

The FTE Bridge module front panel includes three red/green Light Emitting Diodes (LED). The A and B
LEDs monitor port A and port B FTE link integrity and the OK LED monitors general module health. The
following table summarizes possible LED indications.

If OK
LED Is . .
.

Then, It Means . . .

Off No power, watchdog timer expiration, or LED has failed.

Red
(Solid)

Fatal module failure.

Red
(Blinking)

Non-fatal module failure. Also used to indicate firmware update in progress.

Green
(Blinking)

Module is Okay - there are no active connections open to themodule. If
module is part of a redundant pair, themodules are not synchronized.

Green
(Solid)

Module is Okay - one or more active connections are open to themodule. If
module is part of a redundant pair, themodules are synchronized.

If A or B
LED Is . .
.

Then, It Means . . .

Red
(Solid)

Link integrity check failed - no Ethernet signal detected or cable is not
present.

Off Link integrity is OK - no transmit activity.

Green
(Blinking)

Link integrity is OK - there is transmit activity. Typically, the A or B LED blinks
green/off to indicate reception of incoming Ethernet frames over the given
FTE link.

TIP

The A and B Green LEDs blink faster for high Ethernet traffic conditions and may stay on solid in
extreme traffic conditions.
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5.2 Using Control Builder Interface

5.2.1 About Monitoring mode

Once a control strategy is loaded to a controller assigned to a FTE Bridge module, you can interact with
online data through the Monitoring tab in Control Builder. You simply click the Monitoring tab to open it
as shown below.

As shown in the figure above, Control Builder uses color-coding to visually represent the current status
of a given component. The tasks you can perform in the Monitoring mode depend on the access level
you used to sign-on to this session of Control Builder.

Refer to the Control Building Guide for more information about using Control Builder for online
monitoring and other functions.

l Monitoring status through block configuration form

l Viewing Main tab

l Viewing UDP/TCP tab

l Viewing IP/ICMP

l Viewing FTE tab

l Viewing ICP Bridging tab

l Viewing ICP Statistics tab

l Viewing Version tab

l Viewing IOMGR Statistics tab

l Viewing Server History tab

l Viewing Server Displays tab

l Viewing Control Confirmation tab

l Viewing Identification tab
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5.2.2 Monitoring status through block configuration form

The configuration form for the FTE Bridge block includes various tabs that provide access to parameters
for configuration through the Project tab and for monitoring through the Monitoring tab. Use the
following procedure to access the configuration form for a FTE Bridge block in the Monitoring tab. This
procedure assumes that you have logged on to Control Builder and have loaded your control strategy to
the controller.

To access the configuration form for a FTE Bridge block in the Monitoring tab

1. In Control Builder, click the Monitoring tab.

Opens the Monitoring tab.

TIP

You can only view FTE Bridge Blocks in Monitoring tab set for the Assignment view. The
Assignment view shows the relationship among all blocks while the Containment view
only shows templates that contain other templates or Control Modules (CM), Sequential
Control Modules, (SCM) and basic blocks. To toggle the view, right-click in an open
area of the tab window and select Assignment View or Containment View from the
shortcut menu, as applicable.

2. Double-click FTE Bridge block icon.

Opens System: FTEB Block, Name - Parameters [Monitoring] configuration form. Where Name
represents the name configured by the user or assigned by the system.

3. Click tab you want to open. The Main tab opens by default.

Opens selected tab.

4. Repeat Step 3 to view other tabs, as desired.

Select tab you want to view.

5. When finished viewing, click the OK button.

Closes the System: FTEB Block, Name - Parameters [Monitoring] configuration form.

6. This completes the procedure.

Go to the next section.

Refer to the Control Builder Parameter Reference for more details on a given parameter.

5.2.3 Viewing Main tab

The following table summarizes the parameter data you can monitor on the Main tab of the
configuration form for the selected FTE Bridge block. See Monitoring status through block configuration
form for details on accessing the FTE Bridge block configuration form Main tab in the Monitoring tab.

Plain Text Parameter Name
User
Configurable

Notes

Name NAME Project Only System assigned or user
configured unique name.
Consisting of up to 16 characters
and at least one character must be
a letter (A-Z).
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Plain Text Parameter Name
User
Configurable

Notes

Image Version IMAGEVER No Identifies current version of
firmware installed in module.

Device Index DEVICEIDX Project Only
- Matches
Hardware
Setting

Set on FTE Bridgemodule
switches.

Module Slot
Number

SLOTNUMBER Project Only Chassis slot number where FTE
Bridgemodule is installed.

IP Address IPADDRESS No Base IP Address plus configured
Device Index.

Thismodule is
redundant

MODISREDUN Project Only Module is part of redundant pair.

Secondary
Name

SECNAMESTRG Project Only System assigned or user
configured unique name for
secondary block.

Redundant
Chassis ID

RDNCHASSISID No Identifies physical chassis in a
redundant chassis pair without
regard to chassis redundancy
state.

Synchronization
State

RDNSYNCSTATE No Shows current synchronization
state of module.

Redundancy
Compatibility

RDNCMPT No Indicateswhether or not modules
residing in same slot of a
redundant chassis pair are
compatible.

Redundancy
Loss of Sync

RDNLOS No Provides enumeration for loss of
synchronization.

CPU Free
Average

CPUFREEAVG No Gives rolling time average of free
CPU not currently used for
processing byCPM. Units are
percent.

CPU FreeMin CPUFREEMIN No Gives historicminimumof unused
CPU available to CPM. Units are
percent.

Reset Statistics STATRESET No Click button to reset all statistical
parameters for block.
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5.2.4 Viewing UDP/TCP tab

The following table summarizes the parameter data you can monitor on the UDP/TCP tab of the
configuration form for the selected FTE Bridge block. See Monitoring status through block configuration
form for details on accessing the FTE Bridge block configuration form UDP/TCP tab in the Monitoring
tab.

Plain Text Parameter Name
User
Configurable

Notes

UDP Statistics (Provides unreliable connectionless packet delivery service between
clients.)

Datagrams
Delivered

UDPINDGRAMS No Total number of User Datagram
Protocol (UDP) datagrams
delivered to destination protocol
ports.

Datagrams
for Unknown
Ports

UDPNOPORTS No Total number of received UDP
datagrams for which there was
no application at the destination
port.

Datagrams
Dropped for
errors

UDPINERRORS No Number of received UDP
datagrams that could not be
delivered.

Datagrams
Sent to
Applications

UDPOUTDGRAMS No Total number of UDP
datagrams sent from this entity.

TCP Statistics (Provides reliable stream delivery service between clients.)

Active Opens TCPACTIVEOPEN No Number of times TCP
connections havemade a direct
transition to the SYN-SENT
state from the CLOSED state.

Passive
Opens

TCPPASSIVEOPENS No Number of times TCP
connections havemade a direct
transition to the SYN-RCVD
state from the LISTEN state.

Failed
Connection
Attempts

TCPATTEMPTFAILS No Number of times TCP
connections havemade a direct
transition to CLOSED state from
either SYN-SENT state or SYN-
RCVD state, plus number of
times TCP connections have
made a direct transition to
LISTEN state fromSYN-RCVD
state.
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Plain Text Parameter Name
User
Configurable

Notes

Connections
Resets

TCPESTABRESETS No Number of times TCP
connections havemade a direct
transition to CLOSED state from
either ESTABLISHED state or
CLOSE-WAIT state.

Current
Connections

TCPCURRESTAB No Number of TCP connections for
which current state is either
ESTABLISHED or CLOSE-
WAIT.

Segments
Received

TCPINSEGS No Total number of segments
received, including those
received in error.

Segments
Sent

TCPOUTSEGS No Total number of segments sent,
including those on current
connections but excluding those
containing only retransmitted
octets.

Segments
Retransmitted

TCPRETRANSSEGS No Total number of segments
retransmitted - that is, number of
TCP segments transmitted
containing one or more
previously transmitted octets.

Segments
Discarded For
Errors

TCPINERRS No Total number of segments
received in error (for example;
bad TCP checksums).

Reset
Segments
Sent

TCPOUTRESETS No Number of TCP segments sent
containing the RST flag.

Local UDP
Listeners

UDPLISTENERS No Shows path information for all
open ports on the FTE Bridge
module.

Current TCP
Connections

TCPCONNTABLE No Shows path information for all
currently connected clients of
the FTE Bridgemodule.

5.2.5 Viewing IP/ICMP

The following table summarizes the parameter data you can monitor on the IP/ICMP tab of the
configuration form for the selected FTE Bridge block. See Monitoring status through block configuration
form for details on accessing the FTE Bridge block configuration form IP/ICMP tab in the Monitoring tab.
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Plain Text Parameter Name
User
Configurable

Notes

IP Statistics (Provides packet delivery services between nodes.)

Datagrams
Received from
Below.

IPINRECEIVES No Total number of input
datagrams received
from connected nodes,
including those received
in error.

Datagrams
Format Errors
Drops

IPINHDRERRORS No Number of input
datagrams discarded
due to errors in their
Internet Protocol (IP)
headers, including bad
checksums, version
number mismatch, other
format errors, time-to-
live exceeded, errors
discovered in
processing their IP
options, etc.

Datagrams
Misdelivery
Drops

IPINADDRERRORS No Number of input
datagrams discarded
because the IP address
in their IP header's
destination field was not
a valid address to be
received at this entity.

Unknown
Protocol
Datagrams

IPINUNKNOWNPORTS No Number of locally-
addressed datagrams
received successfully
but discarded because
of an unknown or
unsupported protocol.

Datagrams
Discarded for
Resrc

IPINDISCARDS No Number of input IP
datagrams for which no
problemswere
encountered to prevent
their continued
processing, but which
were discarded; for
example, for lack of
buffer space.

Datagrams IPINDELIVERS No Total number of input
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Plain Text Parameter Name
User
Configurable

Notes

Delivered
Above

datagrams successfully
delivered to IP user-
protocols, including
Internet Control
Message Protocol
(ICMP).

Datagram
Sent Out

IPOUTREQUESTS No Total number of IP
datagramswhich local
IP user-protocols
(including ICMP)
supplied to IP in
requests for
transmission.

Out
Datagrams
Discarded

IPOUTDISCARDS No Number of output IP
datagrams for which no
problemwas
encountered to prevent
their transmission to
their destination, but
which were discarded;
for example, for lack of
buffer space.

Datagrams
Drops for No
Routes

IPOUTNOROUTES No Number of IP
datagrams discarded
because no route could
be found to transmit
them to their destination.

Fragments
Needing
Reassembly

IPREASSEMREQS No Number of IP fragments
received which needed
to be reassembled at
this entity.

Fragments
Reassembled

IPREASSEMOKS No Number of IP
datagrams successfully
reassembled.

Fragment
Reassembly
Fails

IPREASSMFAILS No Number of failures
detected by the IP
reassembly algorithm,
for whatever reason:
timed out, errors, etc.

Datagrams
Fragmented

IPFRAGOKS No Number of IP
datagrams that have
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Plain Text Parameter Name
User
Configurable

Notes

been successfully
fragmented at this entity.

Datagrams
Fragmentation
Fails

IPFRAGFAILS No Number of IP
datagrams that have
been discarded because
they needed to be
fragmented at this entity
but could not be. For
example, because their
do not Fragment flag
was set.

Fragments
Created

IPFRAGCREATES No Number of IP datagram
fragments that have
been generated as a
result of fragmentation
at this entity.

Routing
Entries
Discarded

IPROUTINGDISCARDS No Number of routing
entries which were
chosen to be discarded
even though they are
valid.

ICMP Statistics (Controls transmission of error and control messages between hosts
and gateways.)

Messages
Received

ICMPINMSGS No Total number of ICMP
messageswhich the
entity received.

Messages
with Format
Errors

ICMPINERRORS No Number of ICMP
messageswhich entity
received but determined
as having ICMP-specific
errors such as bad
ICMP checksums and
bad length.

Dest.
Unreachable
MsgsRecvd

ICMPINDESTUNREACHS No Number of ICMP
Destination
Unreachablemessages
received.

Echo
Messages
Recvd

ICMPINECHOS No Number of ICMP Echo
(request) messages
received.
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Plain Text Parameter Name
User
Configurable

Notes

Echo Reply
Messages
Recvd

ICMPINECHOREPS No Number of ICMP Echo
Replymessages
received.

Messages
Sent

ICMPOUTMSGS No Total number of ICMP
messageswhich this
entity attempted to send.

Out Error
Messages

ICMPOUTERRORS No Number of ICMP
messageswhich this
entity did not send due
to problems discovered
within ICMP such as a
lack of buffers.

Dest.
Unreachable
Msgs Sent

ICMPOUTDESTUNREACHS No Number of ICMP
Destination
Unreachablemessages
sent.

Echo
Messages
Sent

ICMPOUTECHOS No Number of ICMP Echo
(request) messages
sent.

Echo Reply
Messages
Sent

ICMPOUTECHOREPS No Number of ICMP Echo
Replymessages sent.

5.2.6 Viewing FTE tab

The following table summarizes the parameter data you can monitor on the FTE tab of the configuration
form for the selected FTE Bridge block. See Monitoring status through block configuration form for
details on accessing the FTE Bridge block configuration form FTE tab in the Monitoring tab.

Plain Text Parameter Name
User
Configurable

Notes

FTE Mart Statistics (Provides statistics related to theMAC AddressResolution Table
(MART). This deals with on-linemedia access control (MAC) addressmapping. Two
separate tables aremaintained - One for FTE nodes and one for non-FTE nodes. The
media access control address entry information is obtained by extracting the source
media access control address from received diagnosticmessages.)

AddressCount FTEMARTADDRCOUNT No Number of IP
addresses contained
in FTE MART.

MaxDepth FTEMARTMAXDEPTH No Maximumdepth that
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Plain Text Parameter Name
User
Configurable

Notes

the FTE MART has
reached (largest
number of entries in
table).

Average Depth FTEMARTAVGDEPTH No Average depth of
FTE MART
(average number of
entries in table).

Address
Collisions

FTEMARTCOLLCOUNT No Number of collisions
that have occurred
when hashing the
FTE MART.

Current FTE Traffic

LAN_A TxRate
(kBit/sec)

LANATXRATE No Indicates
communication
transmission rate in
kilobits per second
(kbps) for port A
(Yellow Tree Port)
on the FTE Bridge.

LAN_B TxRate
(kBit/sec)

LANBTXRATE No Indicates
communication
transmission rate in
kilobits per second
(kbps) for port B
(Green Tree Port)
on the FTE Bridge.

LAN_A Rx
Rate (kBit/sec)

LANARXRATE No Indicates
communication
receive rate in
kilobits per second
(kbps) for port A
(Yellow Tree Port)
on the FTE Bridge.

LAN_B Rx
Rate (kBit/sec)

LANBRXRATE No Indicates
communication
receive rate in
kilobits per second
(kbps) for port B
(Green Tree Port)
on the FTE Bridge.
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Plain Text Parameter Name
User
Configurable

Notes

FTM Statistics

Number of FTE
nodes

NUMFTENODES No Current number of
FTE nodeswithin
FTE community.

Max number of
FTE nodes

MAXFTENODES No Maximumnumber of
FTE nodes that have
been detected within
FTE community.

Max node ID MAXNODEID No Highest Device
Index supported
within FTE
community.

IP checksum
errors

BADIPCSUM No Number of FTE IP
messageswhich
were received but
determined as
having bad IP
checksums.

UDP checksum
errors

BADUDPCSUM No Number of FTE
UDPmessages
which were received
but determined as
having bad UDP
checksums.

Non-FTE Mart Statistics

AddressCount NONFTEMARTADDRCOUNT No Number of IP
addresses contained
in non-FTE MART.

MaxDepth NONFTEMARTMAXDEPTH No Maximumdepth that
non-FTE MART has
reached (largest
number of entries in
table.

Average Depth NONFTEMARTAVGDEPTH No Average depth of
non-FTE MART
(average number of
entries in table).

Address
Collisions

NONFTEMARTCOLLCOUNT No Number of collisions
that have occurred
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Plain Text Parameter Name
User
Configurable

Notes

when hashing non-
FTE MART.

Peak FTE Traffic

LAN_A TxRate
Max (kBit/sec)

LANATXRATEMAX No Indicatesmaximum
communication
transmission rate in
kilobits per second
(kbps) for port A
(Yellow Tree Port)
on the FTE Bridge.

LAN_B TxRate
Max (kBit/sec)

LANBTXRATEMAX No Indicatesmaximum
communication
transmission rate in
kilobits per second
(kbps) for port B
(Green Tree Port)
on the FTE Bridge.

LAN_A Rx
RateMax
(kBit/sec)

LANARXRATEMAX No Indicatesmaximum
communication
receive rate in
kilobits per second
(kbps) for port A
(Yellow Tree Port)
on the FTE Bridge.

LAN_B Rx
RateMax
(kBit/sec)

LANBRXRATEMAX No Indicatesmaximum
communication
receive rate in
kilobits per second
(kbps) for port B
(Green Tree Port)
on the FTE Bridge.

LAN_A
(Yellow) failed

LANAFAILED No Status indicator for
port A (Yellow Tree
Port) on the FTE
Bridge. If this LED is
lit, it is an indication
that communications
have failed on Port
A.

LAN_B (Green)
failed

LANBFAILED No Status indicator for
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Plain Text Parameter Name
User
Configurable

Notes

port B (Green Tree
Port) on the FTE
Bridge. If this LED is
illuminated it is an
indication that
communications
have failed on Port
B.

InterLAN
comm. failed

INTERLANFAILED No Status indicator for
Inter-LAN
communications -
indicates that inter-
LAN
communications
have failed.

Crossover
cable failed

XOVERFAILED No Status indicator for
Crossover cable -
indicates that the
Crossover cable has
failed.

5.2.7 Viewing ICP Bridging tab

The following table summarizes the parameter data you can monitor on the ICP Bridging tab of the
configuration form for the selected FTE Bridge block. See Monitoring status through block configuration
form for details on accessing the FTE Bridge block configuration form ICP Bridging tab in the Monitoring
tab.

Plain Text Parameter Name
User
Configurable

Notes

Originators

Application
Connection Id

ORIAPPCONNID
[1..48]

No Initiator's Application
Connection ID

Connection State ORICONNSTATE
[1..48]

No Initiator's Connection State

Number Of
Initiators Using

ORIMUXED[1..48] No Number of initiators using
multiplexed connections.

Path ORIPATH[1..48] No Initiator's Connection Path

Transport Class ORITCLASS[1..48] No Initiator's Transport Class
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Plain Text Parameter Name
User
Configurable

Notes

Targets

Application
Connection Id

TGTAPPCONNID
[1..24

No Target's Application Connection
ID

Connection State TGTCONNSTATE
[1..24

No Target's Connection State

Transport Class TGTTCLASS
[1..24]

No Target's Transport Class

5.2.8 Viewing ICP Statistics tab

The following table summarizes the parameter data you can monitor on the ICP Statistics tab of the
configuration form for the selected FTE Bridge block. See Monitoring status through block configuration
form for details on accessing the FTE Bridge block configuration form ICP Statistics tab in the
Monitoring tab.

Plain Text Parameter Name
User
Configurable

Notes

Reset ICP
Statistics
(Button)

ICPSTATRESET N/A Click to reset ICP statistics,
when available.

ICP General Statistics

Open Requests
Received

RECVOPENREQ No Number of open requests
received.

Open
Responses Sent

SENDOPENRSP No Number of open responses
sent.

Open Requests
Sent

SENDOPENREQ No Number of open requests
sent.

Open
Responses
Received

RECVOPENRSP No Number of open responses
received.

Close Requests
Received

RECVCLOSEREQ No Number of close requests
received.

Close Requests
Sent

SENDCLOSEREQ No Number of close requests
sent.

Close
Responses
Received

RECVCLOSERSP No Number of close responses
received.
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Plain Text Parameter Name
User
Configurable

Notes

Close
Responses Sent

SENDCLOSERSP No Number of close responses
sent.

ICP Error Statistics

Connected Send
Errors

CONNSENDERR No Number of connected send
errors.

Un-Connected
Send Errors

UNCONNSENDERR No Number of unconnected send
errors.

Connection
Open Failures

CONNOPENFAIL No Number of connection open
failures.

Connection
Close Failures

CONNCLOSEFAIL No Number of connection close
failures.

Connection
Open Rejects

CONNOPENREJECT No Number of connection open
rejects.

NAKS Received RECVNAKS No Number of negative
acknowledgements (NAKS)
received.

5.2.9 Viewing Version tab

The Version tab is common to all configuration forms for tagged blocks in Control Builder. If you have a
Qualification and Version Control System (QVCS) license, this tab shows current QVCS information for
the selected FTE Bridge block. Refer to the online help and the Qualification and Version Control
System User's Guide for more information about the data on this tab. See Monitoring status through
block configuration form for details on accessing the FTE Bridge block configuration form Version tab in
the Monitoring tab.

5.2.10 Viewing IOMGR Statistics tab

The following table summarizes the parameter data you can monitor on the IOMGR Statistics tab of the
configuration form for the selected FTE Bridge block. See Monitoring status through block
configuration form for details on accessing the FTE Bridge block configuration form IOMGR Statistics
tab in the Monitoring tab.

Plain Text
Parameter
Name

User
Configurable

Notes

C300
IOMGR
Client IP

IOMGRCLI No Shows the C300 IP address to which this
FTEB IOmanager is connected.

Number of
IOM's

NUMIOM No Specifies the number of Series A IOM's
configured to this FTEB block. Note that only
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Plain Text
Parameter
Name

User
Configurable

Notes

configured 16 IOM's can be configured per FTEB block.

Connection status table

IOModule
Name

IOMNAME No Name of the configured IOM

ASA path
of the IO
Module

IOMASAPH No ASA path of the configuredmodule

IOM
Connection
Status

CONNSTAT No Current connection status

Last Open
Conn Error

CONNERR No Last open connection error status

5.2.11 Viewing Server History tab

ATTENTION

The configuration settings you make for Server Load Options on the System Preferences dialog
determines whether or not the data entered on the Server History tab is loaded to the Experion
Server. See the Control Building Guide for information about setting system preferences.

Plain Text Parameter Name
User
Configurable

Notes

Access Levels

Control Level SCANCTRLLVL Yes Indicates Server control level to
be associated with this function.

Control Area SCANAREA Yes Indicates the Server control area
to be associated with this
function.

History Configuration

Number of
History
Parameters

HIST.NUMPARAMS Yes Defines number of history
parameters to be included in
History Configuration table.

Parameter Yes Valid parameter name for a
parameter associated with the
given point that is to be collected
and stored as historical data at
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Plain Text Parameter Name
User
Configurable

Notes

predetermined intervals.

Description No Provides a brief description of
the entered parameter.

FAST Yes Select the Fast type of history
collection.

STD Yes Select the Standard type of
history collection.

EXTD Yes Select the Extended type of
history collection.

Gating
Parameter

Yes Optional gating parameter to
define conditions under which
data for this parameter must be
collected.

Gate State Yes Defines gate state for configured
gating parameter.

Create New or
Edit Existing
Server Scripts
(Button)

N/A Launch the Server scripting
configuration utility.

5.2.12 Viewing Server Displays tab

The Server Displays tab is common to all configuration forms for tagged blocks in Control Builder. The
following table summarizes the parameter data you can monitor on this tab of the configuration form for
the selected FTE Bridge block. See Monitoring status through block configuration form for details on
accessing the FTE Bridge block configuration form Server Displays tab in the Monitoring tab.

ATTENTION

The configuration settings you make for Server Load Options on the System Preferences dialog
determines whether or not the data entered on the Server Displays tab is loaded to the Experion
Server. See the Control Building Guide for information about setting system preferences.

Plain Text Parameter Name
User
Configurable

Notes

Point
Detail
Display

SCANPNTDTL Yes By default, a Display template is
already entered into Point Detail
Display box (for example,
sysDtlFTEB.dsp). This template
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Plain Text Parameter Name
User
Configurable

Notes

can be used for creating your own
display or it can be used as is,
provided that your function block
namematches name built into
detail display that is supplied as a
template.

Group
Detail
Display

SCANGRPDTL Yes By default, a Display template is
already entered into the Group
Detail Display box (for example,
sysGrpFTEB.dsp). This template
can be used for creating your own
display or it can be used as is,
provided that your function block
namematches name built into
detail display that is supplied as a
template.

Associated
Display

SCANASSOCDSP Yes Name of the Server display to be
associated with this function
block.

Trends

Number of
Trends

TREND.NUMPARAMS Yes Defines the number of trend
parameters to be included in the
TrendsConfiguration table.

Trend # Yes Defines Trend number to be
associated with this trend
parameter.

Pen Yes Defines color of pen that will be
used to trace assigned parameter
on Station Trend display.

Trend
Parameter

Yes Valid parameter name for a
parameter associated with given
point that is configured for history
collection.

Description No Provides a brief description of the
entered parameter.

Groups

Number of
Groups

GROUP.NUMPARAMS Yes Defines the number of group
parameters to be included in
GroupsConfiguration table.
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Plain Text Parameter Name
User
Configurable

Notes

Group # Yes DefinesGroup number to be
associated with this group
parameter.

Pos # Yes Defines number of position
configured parameter will occupy
in the Station Group display.

Group
Parameter

Yes Valid parameter name for a
parameter associated with the
given point that is configured in
the system.

Description No Provides a brief description of the
entered parameter.

5.2.13 Viewing Control Confirmation tab

The Control Confirmation tab is common to all configuration forms for tagged blocks in Control Builder.
If you have an optional Electronic Signature license, you can configure electronic signature information
for the tagged block through this tab on the block's configuration form in Control Builder. Refer to the
online help and the Server and Client Configuration Guide for information about the data on this tab.

The Electronic Signature function aligns with the identical Electronic Signatures function that is initiated
through Quick Builder and Station for Server points. When this block is loaded to a controller, its control
confirmation configuration (electronic signatures) is also loaded to the Server. This means you can view
the control confirmation configuration for this tagged object in Station and make changes to it. If you
make changes through Station, you must initiate an Upload or Upload with Contents function through
the Controller menu in Control Builder for the object in the Monitoring tab to synchronize changes in the
Engineering Repository Database (ERDB).

5.2.14 Viewing Identification tab

The Identification tab is common to all configuration forms for tagged blocks in Control Builder. The
following table summarizes the parameter data you can monitor on this tab of the configuration form for
the selected FTE Bridge block. See Monitoring status through block configuration form for details on
accessing the FTE Bridge block configuration form Identification tab in the Monitoring tab.

Plain Text Parameter Name
User
Configurable

Notes

Name NAME Yes Unique block name consisting of up to
16 characters to identify the block. At
least one character in the namemust
be a letter (A-Z).

Description DESC Yes Descriptive text appears on detail and
group displays to uniquely describe this
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Plain Text Parameter Name
User
Configurable

Notes

particular function block.

Block
Comment
1

BLCKCOMMENT1 Yes Comment to be associated with this
block consisting of up to 40 characters.

Block
Comment
2

BLCKCOMMENT2 Yes Comment to be associated with this
block consisting of up to 40 characters.

Block
Comment
3

BLCKCOMMENT3 Yes Comment to be associated with this
block consisting of up to 40 characters.

Block
Comment
4

BLCKCOMMENT4 Yes Comment to be associated with this
block consisting of up to 40 characters.

Library No Identifies Control Builder Library that is
source of template.

System
Template

No Identifies SystemTemplate that is
source for this block.

Base
Template

No Identifies Base Template that is used
for this block.

Created By CREATEDBY No Identifies user who created block, if
operator security is implemented.
Otherwise, may just show Default
login.

Date
Created

DATECREATED No Shows date and time template was
created. If this block is in Version
Control System, shows date and time
initial version of template was created.

Last
Modified
By

MODIFIEDBY No Identifies user whomade last
modifications to block, if operator
security is implemented. Otherwise,
may just show default login. If this block
is in Version Control System,
modifications apply to last version of
block.

Date Last
Modified

VERSIONDATE No Shows date and time last modification
wasmade to block's configuration. If
this block is in Version Control System,
modification date and time applies to
last version of block.
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5.3 Using Network Tools (NTools) Utility

5.3.1 About NTools

The NTools utility lets you view the online status of the chassis mounted hardware. It lets you quickly
confirm the firmware revision levels and slot locations of all modules. It supports both ControlNet and
Ethernet communications media.

Refer to the Control Hardware Troubleshooting and Maintenance Guide for more information about the
NTools utility.

l Launching NTools in Ethernet mode

5.3.2 Launching NTools in Ethernet mode

Prerequisites

l If you are running R210 or greater software, you launch NTools through Configuration Studio.

l On the Configuration Explorer tab, click the Control Strategy icon and click Maintain control system
firmware selection in the I/O and Network Maintenance box.

l In this case, skip Steps 1 and 2 in the following procedure.

To launch NTools in the Ethernet mode

1. On the taskbar, click the Start button, and then click Run.

Opens the Run dialog.

2. In Open box, type ntools -e -u. click the OK button

l Launches Network Tools utility in Ethernet mode (-e) with ability to update firmware versions (-
u).

l Opens Network Tools dialog with warning message.

3. Click the OK button.

Acknowledge the warning about monitoring through Control Builder.

4. On the toolbar, click the Resume button.

Starts the network scan.

5. If this is the initial launch of NTools, click the Settings button.

Opens the Settings dialog.

6. Select the desired scanning options. The defaults are:

l Delay between scans (seconds) - 2

l Periodic (automatic) - selected

l Enable mode version/revision checking - checked

l Enable ControlNet Parameter checking - checked

l Click the OK button.

Adjust scanning to your requirements.
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ATTENTION

You must create a FTE Bridge block in Control Builder before you can view it in the
Network Tools (NTools) utility.

7. Click the first FTEB icon under the Desktop tree.

l If this is the initial NTools launch, the Settings dialog opens. Go to the Next step.

l If this is not the initial NTools launch, go to Step 9.

8. Fill in the appropriate data for the Local and Remote chassis configurations in your network
associated with the given FTE Bridge module. Click the OK button.

Closes Settings dialog and defines your system configuration for viewing.

9. Once the graphic representation of the chassis appears in the Detail pane, individual modules can
be selected, which results in the applicable menu commands becoming available.

Lets you view hardware details and confirm firmware revision levels for modules installed in the
chassis. Refer to the Network Tools Help for more information about menu commands.

10. Click NetworkTools menu and then click Exit.

Closes the NTools utility.

11. This completes the procedure.

Go to the Next section.

5.4 Using Station Displays

5.4.1 Viewing Detail or Group displays

The Experion Server Station application includes pre-configured Detail and Group displays for FTE
Bridge blocks. These displays are default entries for the Point Detail Display (sysDtlFTEB.dsp) and
Group Detail Display (sysGrpFTEB.dsp) parameters on the Server Displays tab of the FTE Bridge block
configuration form. Once you load a FTE Bridge block, you can begin monitoring the Detail displays
through Station. The Detail displays provide convenient access to the same information found on the
FTE Bridge block configuration form tabs in Monitoring mode.

Refer to the Operator's Guide for detailed information about calling up, navigating, and viewing station
displays.

l Viewing Event Summary display

5.4.2 Viewing Event Summary display

Like the Details displays, the Station Alarm and Event Summary displays support integration of FTE
Bridge module generated alarms and events through the Network Diagnostic Manager (NDM). The
configured FTE Bridge block tags will be used to identify the FTE Bridge module generating the event.

5.5 FTE Bridge Redundancy Operation Considerations

5.5.1 About redundancy
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If you have redundancy compliant hardware, you can implement redundant CPM/IOLIM/FIM operation
through a Redundant Chassis Pair (RCP). A RCP consists of two chassis which include identical
redundancy compliant modules in matching slot positions within their given chassis. The following
figure shows a typical hardware configuration for a RCP that includes a Control Processor Module
(CPM) and a Fieldbus Interface Module (FIM). The RCP does not need CPMs to support FIM
redundancy. It does need one pair of Redundancy Modules (RMs) though.

l RM based redundancy

l Switchover and Secondary readiness

l Failure conditions and switchover

l FTE Bridge switchover considerations

5.5.2 RM based redundancy

Redundancy Modules in a Redundant Chassis Pair (RCP) configuration provide redundant
functionality. The RCP does this by providing a pair of chassis, so a component failure in one chassis
switches the handling of the assigned functions to the other chassis. This is considered a dual
redundant system, which is characterized by the following two main redundancy states.

l Primary - Refers to the chassis executing the assigned control functions.

l Secondary - Refers to the chassis in some state of readiness to assume the responsibilities of the
Primary.
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Refer to the Controller Redundancy Functionality section in the Control Builder Components Theory for
more information about Controller redundancy.

5.5.3 Switchover and Secondary readiness

A switchover describes the process where a Secondary chassis assumes the Primary state, and the
Primary chassis assumes the appropriate Secondary state of readiness, depending upon what
triggered the switchover. A switchover can be triggered immediately upon the detection of a fault in the
Primary or upon the receipt of an operator command.

The ability of a Secondary chassis to take over the assigned control functions of the Primary depends
upon which one of the following readiness states reflects its current state.

If Secondary
Chassis State
is . . . Then, the Secondary Chassis . . .

Disqualified Cannot assume the Primary state. This is a state of non-readiness.

Synchronizing Cannot assume the Primary State. In this state, the Secondary
chassis is copying database information from the Primary.

Synchronized Can assume the Primary state upon switchover. In this state, the
database in the Secondary is aligned with the database in the Primary.
The Secondary closely tracks database changes tomaintain its
synchronization with the database of the Primary. Otherwise, the
Secondary will revert to a Disqualified state.

5.5.4 Failure conditions and switchover

The following table identifies failure conditions that result in a switchover and those that do not.

ATTENTION

When any failure that results in a switchover occurs in a Secondary, the Secondary chassis loses
synchronization.

In addition to the failure conditions, these events are reported as diagnostic notifications:

l Loss of view of redundant partner on H1 network (applies to FIM link).

l Loss of private path connection from Primary to Secondary (lonely event).

Failure Conditions That Result in a
Switchover

Failure Conditions That Do Not
Result in a Switchover

Power to Primary chassis fails. One or both fieldbusH1 cables fail.

Integrated Control Protocol (ICP) backplane in
primary chassis fails.

One or both fieldbusH1 network
conditioners fail.
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Failure Conditions That Result in a
Switchover

Failure Conditions That Do Not
Result in a Switchover

Anymodule in Primary chassis fails. The 24-Volt power supply fails.

Both FTE links to Primary FTE Bridgemodule
are lost, and the secondarymodule has at least
one healthy link.

One FTE link to Primary FTE Bridge
module is lost. The secondary has
both links healthy.

Primary FIM's connection to Redundant
Remote Terminal Panel fails.

5.5.5 FTE Bridge switchover considerations

For FTE Bridge modules in a redundant chassis pair, the primary FTE Bridge module does not fail, if it
loses communication with both FTE links. In this case, the primary FTE Bridge module initiates a
switchover request to the Redundancy Module to switch control to the secondary chassis, assuming it is
in a qualified state. The following are some considerations associated with a FTE Bridge module
initiated switchover.

For this
Switchover
Consideration
. . . FTE Bridge Redundancy Operation . . .

Device Index
number

Does not transition the Device Index for the primary FTE Bridge
module to the secondary FTE Bridgemodule. The Device Index stays
with the physical FTE Bridgemodule.

MAC
Addresses

Does not transition theMAC addresses for the FTE links on the
primary FTE Bridgemodule to the secondary FTE Bridgemodule. The
MAC addresses stay with the physical FTE Bridgemodule.

IP Address Does swap IP addresses for primary and secondary FTE Bridge
modules during switchover as follows:

l During initial synchronization, primary and secondary FTE Bridge
modules exchange their IP addresses over the private redundancy
link. This is for verification purpose only, since the odd-even
convention allows bothmodules to determine their partner's
address based on their own address.

l During switchover or swap, both primary and secondary FTE
Bridgemodules replace their current IP address with their
partner's IP address. This puts redundant pair into transient state
in which peer modules are temporarily unable to communicate with
either one of them, since their address tables are no longer valid
due to the IP address swap.

l After IP address swap, both primary and secondary FTE Bridge
modules construct AddressResolution Protocol (ARP) request
packets with updated IP-to-Ethernet addressmapping and
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For this
Switchover
Consideration
. . . FTE Bridge Redundancy Operation . . .

broadcast them on the network. Upon reception of ARP packets,
peer nodes update their address tables.

ATTENTION

The swapping of IP addresses is transparent to the higher-level protocols such as Transmission
Control Protocol (TCP) or User Datagram Protocol (UDP).

l TCP packets sent to either primary or secondary FTE Bridge module during switchover
will be re-tried. Once retry limit is exceeded, connection breaks and gets re-established
by application based on updated address information.

l UDP packets sent to either primary or secondary FTE Bridge module during switchover
and before client address table is updated will be lost.
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SERVICE

l Maintenance considerations

l Updating FTE Bridge module firmware

l Configuration changes and migration scenarios

l Migrating from ControlNet or Ethernet supervisory network

l Migration from FTE based C200 to C300

l Import/export and on-process migration support

l Troubleshooting

6.1 Maintenance considerations

6.1.1 Periodic checks

Check the front-panel indicators periodically to ensure all segments of the 4-character display and the
light emitting diodes (LED) are working. If segment or LED is not lit or has dimmed, you must replace
the FTE Bridge module, since front-panel indicators are not field replaceable.

Refer to the Removal and Insertion Under Power (RIUP) Function Guidelines in the Control Hardware
Installation Guide before you RIUP any module.

l Remove and replace FTE Bridge module TC/TK-FTEB01

l Spare parts

6.1.2 Remove and replace FTE Bridge module TC/TK-FTEB01

ATTENTION

We recommend that you proceed with extreme caution whenever replacing any component in a
control system. Ensure the system is offline or in a safe operating mode.

Component replacements may also require corresponding changes in the control strategy
configuration through Control Builder, as well as downloading appropriate data to the replaced
component.
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To remove and replace a FTE Bridge module

1. On the Project tab in Control Builder, double click the icon for the FTE Bridge block that represents
the FTE Bridge module to be replaced.

Opens SYSTEM:FTEB Block, XXXXX- Parameters [Project] configuration form. Where XXXXXX
equals the assigned name.

2. On the Main tab, record the Image Version and Device Index number listed for reference. Click the
Cancel button.

Records data for future reference and closes the form.

3. Is the FTE Bridge Module to be replaced installed in a non-redundant chassis configuration or in a
redundant chassis pair configuration?

l If answer is non-redundant chassis, go to Step 5.

l If answer is redundant chassis pair, go to Step 4.

4. If FTE Bridge module to be replaced is currently running as the Primary, initiate a switchover to
make it the secondary.

Ensure the FTE Bridge module to be replaced is functioning as the secondary, so power to the
chassis can be turned off. Skip Step 5 and go to Step 6.

5. Put the Controller in its idle state and ensure the backup battery is functioning.

Prepare the non-redundant Controller chassis for shutdown.

6. Flip the switch on the chassis power supply to the Off position.

Remove power from the chassis.

7. Open the front-panel door and unplug the primary and secondary cable connectors from the
sockets on the module.

Prepare module for removal.

8. Push in the top and bottom locking tabs and pull the FTE Bridge module from its chassis slot.

Remove the module from the chassis.

9.

l Note if cable shield ground jumpers are installed or not. See Checking cable shield ground
jumper for more information.

l Confirm that Device Index number set on BCD rotary switches on the module agrees with the
one recorded in Step 2. See Setting unique Device Index for more information.

Confirm settings on the removed module.
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10. On the new FTE Bridge module, ensure the cable shield ground jumpers and BCD rotary switches
(Device Index) settings match those on the removed module.

Make sure settings on the new module match those on the removed module.

11. Align the module's circuit board with the top and bottom chassis guides for the slot just vacated by
the removed module.

12. Slide the module into the chassis, until the module's locking tabs "click" into position. The module is
fully installed when it is flush with the power supply or other installed modules.

13. Open the front-panel door, connect yellow and green FTE cable connectors to applicable sockets
on the module. See Attaching FTE cables for more information. Close the front-panel door.

Connect FTE link cables.

14. Ensure the BOOTP Server service is started. See Checking status of BOOTP server service for
more information.

Confirm that BOOTP Server is running.

15. Flip the switch on the chassis power supply to the On position.

Restore power to the chassis.

16. Monitor the front-panel 4-character display to confirm that the module receives its IP address. See
Applying power to FTE Bridge Module for more information.

Confirm that module is operating.

17. Use the Network Tools utility to check that firmware revision of the new module matches the one
recorded in Step 2. See Launching NTools in Ethernet mode for more information.

l If firmware revision is correct, go to Step 18.

l If firmware revision is not correct, go to the Updating FTE Bridge module firmware section and
then return to Step 17.

18. If you need to replace the other FTE Bridge module in a redundant chassis pair, wait for the primary
and secondary chassis to synchronize and then repeat this procedure following the steps for a
redundant chassis pair.

Replace both modules in a redundant chassis pair.

19. This completes the procedure.

Return to normal operation.

6.1.3 Spare parts

The FTE Bridge module is not field repairable and the only replacement part is the module itself. The
following table lists the recommended spares based on the number of modules installed.

Model Number

Recommended Spares

Per 10 Per 100

TC-FTEB01 (uncoated) 1 5

TK-FTEBO1 (coated) 1 5
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6.2 Updating FTE Bridge module firmware

ATTENTION

If the FTE Bridge module is not installed and pre-configured by the factory, users must load the
FTE Bridge module's firmware to make it fully operational. This is also true for any replacement
FTE Bridge module ordered separately from the factory.

l Checking firmware status

l Checking firmware version

l Loading Boot code

l Loading Personality image

6.2.1 Checking firmware status

To check firmware status

1. If chassis is not powered, flip the switch on the chassis power supply to the On position.

Applies power to the chassis and installed modules initiate their "boot" routines.

2. Wait a few minutes for the modules to reach their normal operating states. Check the 4-Character
LED display on the FTE Bridge module.

l If the Device Index number and OK or BKUP are sequencing in the FTE Bridge module
display, the module is operating and contains some version of firmware. In this case, go to the
next procedure Checking firmware version. If RDY appears in the FTE Bridge module display,
go to the procedure Loading Boot code.

l If ALIV appears in the FTE Bridge module display, go to the procedure Loading Personality
image.

3. This completes the FTE Bridge module firmware status check.

Go to the next appropriate procedure.

6.2.2 Checking firmware version

To check firmware version

1. Launch Network Tools. See Launching NTools in Ethernet mode for more information.

Opens Network Tools utility.
2.

l Click the OK button to acknowledge the message prompt.

l Click the Resume button in the toolbar.

NTools begins scanning the network for installed components. Detected nodes will appear under
the Desktop directory.
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ATTENTION

You must load a FTE Bridge block or have a ControlNet Interface (CNI) module installed
in a chassis before you can view other installed but not loaded FTE Bridge modules in
the Network Tools (NTools) utility.

3. Click the node icon.

Graphic representation of the chassis for the selected node appears in the Detail pane.

4. Check the boot version (BV) and application (personality) version (AV) listed on the face of the FTE
Bridge module (FTEB01) graphic.

If the version numbers shown are colored green, they are the correct ones for your current system
software version. If they are colored red, they need to be updated.

5.

l If firmware versions are correct (green), click NetworkTools > Exit.

l If firmware versions are wrong (red), go to the next sub-procedure Loading Boot code to
continue.

l Closes the utility and you can quit this procedure.

l Continue with the next sub-procedure.

6.2.3 Loading Boot code

This procedure assumes that you have launched NTools and determined that the FTE Bridge module
firmware needs to be updated or the FTE Bridge has started up in the RDY mode.

To load boot code

1. Click the FTE Bridge module (FTEB01) graphic in the chassis representation in the Detail pane.

A red box appears around the graphic to show that it is selected.

2. Click the Flash button in the toolbar.

Opens Warning! Use Extreme Care dialog.

3. Click the Yes button to acknowledge that the system is Offline.

Opens Confirm Changes dialog.

4. Click the Yes button to acknowledge that it is okay to shutdown the FTE Bridge module.

Initiates shutdown and reboot of the FTE Bridge module and calls up the Open dialog.
5.

l In the Look in box, click the arrow button to navigate to this directory location c:\Program
Files\Honeywell\Experion\Engineering Tools\system\firmware\FTEB, if required.

Opens Confirm Changes dialog. This illustration is for example purposes only.
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6. Click the Yes button to acknowledge that you want to proceed with the update. (Note that RDY
must appear in the FTE Bridge module display)

l Initiates firmware load. LOAD appears in the FTEB display.

l Progress of the load is tracked in the status bar.

7. Wait for the load to complete and the FTE Bridge module to reboot to its ALIV state.

NetworkTools message appears.

8. Click the OK button to acknowledge that the update completed with no errors.

Wait for the NTools to complete its next scan.

9. Check that the updated boot version (BV) now appears on the FTE Bridge module graphic in
green.

Confirm that load completed successfully.

10. This completes the procedure.

Go to the next procedure Loading Personality image to continue the firmware update.

6.2.4 Loading Personality image

This procedure assumes that you have just completed the previous procedure or the FTE Bridge has
started up in the ALIV mode.
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To load personality image

1. With FIM graphic still selected, click the Flash button.

Opens Warning! Use Extreme Care dialog.

ATTENTION

Depending on when this function is initiated, you may be asked to confirm the changes
and the FTE Bridge module will be rebooted before you can access the Open dialog.

2. Click the Yes button to acknowledge that system is still Offline.

Opens the Open dialog.
3.

l In the Look in box, click the Arrow button to navigate to this directory location c:\Program
Files\Honeywell\Experion\Engineering Tools\system\firmware\FTEB, if required.

l Click ftebrex.nvs file so it appears in the File name box. Click the Open button.

Opens the Confirm Changes dialog.

4. Click the Yes button to acknowledge that you want to proceed with the update.

l Initiates the firmware load. LOAD appears in the FTE Bridge module display.

l Progress of the load is tracked in the status bar.

5. Wait for load to complete and the FTE Bridge module to reboot to its normal run state.

NetworkTools message appears.

6. Click the OK button to acknowledge that the update completed with no errors.

Wait for NTools to complete its next scan.

7. Check that the updated application (Personality) version (AV) now appears on the FTE Bridge
module graphic in green.

Confirm that load completed successfully.

8. This completes the FTEB Bridge module firmware update.

Go to the next appropriate section.

6.3 Configuration changes and migration scenarios

l Changing base IP address

l Changing the Device Index or slot number for a configured FTE Bridge module

l Upgrading non-redundant chassis to redundant chassis pair

6.3.1 Changing base IP address

If you must change your base IP address, use the following procedure as a guide. The following
procedure assumes that you are logged onto Control Builder with the necessary security level to
implement control strategy changes and you are familiar with using Control Builder to create and edit
control strategies.
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To change base IP address

1. On the Monitoring tab, inactivate and delete any and all devices.

2. On the Tools menu, click System Preferences to call up the dialog.

3. On the System Preferences dialog, click the Embedded FTE tab.

4. Click the Edit network parameters check box to select it.

5. Key in the new base IP address in the Base IP Address field.

6. If applicable, change Subnet Mask and Default Gateway as well as SNTP Primary Server and
Secondary Server addresses.

7. Click the OK button to close the dialog and save the changes. If applicable, follow on-screen
prompts to correct any errors. Otherwise, click the OK button to acknowledge the Control Builder
warning message.

8. Restart any remote Control Builder applications.

9. Reboot any embedded device that already received its IP address from the previous network
configuration.

10. Reload your control strategy and continue normal operation.

6.3.2 Changing the Device Index or slot number for a configured FTE
Bridge module

If you want to change the Device Index number or slot location of an existing, configured FTE Bridge
module, use the following procedure as a guide. The following procedure assumes that you are logged
onto Control Builder with the necessary security level to implement control strategy changes and you
are familiar with using Control Builder to create and edit control strategies.

To change Device Index or Slot number for a configured FTE Bridge module

1. Is your control strategy loaded and running?

l If the answer is Yes, go to the next Step.

l If the answer is No, go to Step 4.

2. On Monitoring tab, inactivate Control Execution Environment (CEE) and associated Control
Modules, Sequential Control Modules, and I/O Modules for all Controllers assigned to the FTE
Bridge module targeted for change. Do the same for any assigned Fieldbus Interface Modules
(FIMs) and links, and I/O Link Interface Modules (IOLIM) and links.

You must inactivate control strategy components before you can delete them.

3. On Monitoring tab, delete all control strategy components associated with FTE Bridge block and
then delete the FTE Bridge block.

You must delete control strategy components from Monitoring tab before you can unassign
components in the Project tab.

TIP

l It may be helpful to initiate a Project Tree Charts printout through the Print
command on the File menu before you unassign and delete components in the
Project tab.

l If you have a Qualification and Version Control System license, there will be
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additional steps required to check out a component before you can modify it in
Control Builder.

4. On Project tab, unassign all container type blocks, I/O modules, and devices from their respective
Control Processor Module (CPM), FIM, and/or IOLIM.

You must unassign components before you can delete a CPM, FIM, or IOLIM block.

5. On Project tab, delete CPMs, FIMs, and IOLIMs associated with the FTE Bridge module, and then
delete the FTE Bridge block.

You must delete controllers, so you can configure them for association with the changed FTE
Bridge module.

ATTENTION

If you are making changes to a FTE Bridge module in a redundant chassis pair, ensure
you make corresponding changes in the partner FTE Bridge module to maintain the
proper odd/even Device Index numbering scheme and the installation of modules in
matching slot locations.

6.

l To change the FTE Bridge module's Device Index number, see Setting unique Device Index
for details.

l To change the FTE Bridge module's slot position, adapt the steps in the previous procedure
Remove and replace FTE Bridge module TC/TK-FTEB01 to install the module in another slot in
the chassis.

Make desired FTE Bridge module Device Index and/or slot position changes.

7. Configure new FTE Bridge block for changed FTE Bridge module. See Creating FTE Bridge
module block for details.

Must configure FTE Bridge block before you configure CPM, FIM, and/or IOLIM blocks.

8. Configure new CPM, FIM and/or IOLIM blocks for the ones deleted in Step 5.

Associate controllers with changed FTE Bridge module.

9. On Project tab, assign all container type blocks, I/O modules, and devices that were unassigned in
Step 4 to their respective Control Processor Module (CPM), FIM, and/or IOLIM.

Reestablish control strategy associations.

10. Load the FTE Bridge block. See Loading FTE Bridge block for details.

FTE Bridge block appears in Monitoring tab.

11. Load the rest of the blocks that make up the control strategy.

All blocks for the control strategy appear in the Monitoring tab.

12. This completes the procedure.

Resume normal operation.

6.3.3 Upgrading non-redundant chassis to redundant chassis pair

Use this procedure as a general guide to upgrade an existing non-redundant C200 Controller or
Fieldbus Interface Module chassis to be a redundant chassis pair. This procedure assumes that you are
aware of the basic requirements for implementing a redundant chassis pair and focuses only on the
changes relevant to FTE Bridge modules. See About redundancy for basic information about a
redundant chassis pair.
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To upgrade non-redundant chassis to redundant chassis pair

1. On Monitoring tab, inactivate Control Execution Environment (CEE) and associated Control
Modules, Sequential Control Modules, and I/O Modules for all Controllers assigned to the FTE
Bridge module targeted for upgrade to a redundant chassis pair. Do the same for any assigned
Fieldbus Interface Modules (FIMs) and links, and I/O Link Interface Modules (IOLIM) and links.

You must inactivate control strategy components before you can delete them.

2. On Monitoring tab, delete all control strategy components associated with FTE Bridge block and
then delete the FTE Bridge block.

You must delete control strategy components from Monitoring tab before you can unassign
components in the Project tab.

TIP

l It may be helpful to initiate a Project Tree Charts printout through the Print
command on the File menu before you unassign and delete components in the
Project tab.

l If you have a Qualification and Version Control System license, there will be
additional steps required to check out a component before you can modify it in
Control Builder.

3. On Project tab, unassign all container type blocks, I/O modules, and devices from their respective
Control Processor Module (CPM), FIM, and/or IOLIM.

You must unassign components before you can delete a CPM, FIM, or IOLIM block.

4. On Project tab, delete CPMs, FIMs, and IOLIMs associated with the FTE Bridge module, and then
delete the FTE Bridge block.

You must delete controllers, so you can configure them for association with the redundant FTE
Bridge module.

5. Flip the power supply switch to Off on the existing non-redundant power supply module located on
the left side of the chassis.

Remove power from the chassis before removing and inserting modules.

6. Remove the FTE Bridge module from the non-redundant chassis and set its Device Index to
desired odd number. See Setting unique Device Index for details.

The FTE Bridge module in the existing non-redundant chassis becomes the primary FTE Bridge
module in the redundant chassis pair.

7. Install the Redundancy Module in the appropriate slots in the non-redundant chassis.

All modules in redundant chassis pair must be redundancy compliant and installed in matching slot
locations.

8. Install the secondary chassis and check that the Device Index number on the FTE Bridge module
in this chassis is the next even number following the odd number set for the Primary FTE Bridge
module. Also, ensure cable shield jumpers are installed or removed, as required.

Ensure FTE Bridge modules in redundant chassis pair have appropriate odd/even Device Index
numbers.

9. Connect the dedicated cable between the Redundancy Modules and connect the FTE cables to
the secondary FTE Bridge module. Make any other field connections to the secondary chassis, as
required.

Make all network and field connections to modules in the chassis.

10. Configure new redundant FTE Bridge blocks for FTE Bridge modules in redundant chassis pair.
See Creating FTE Bridge module block for details.

Must configure FTE Bridge block before you configure CPM, FIM, and/or IOLIM blocks.
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11. Configure new redundant CPM, FIM and/or IOLIM blocks for the ones deleted in Step 4.

Associate controllers with redundant FTE Bridge modules.

12. Configure new Redundancy Module (RM).

Support redundant chassis pair.

13. On Project tab, assign all container type blocks, I/O modules, and devices that were unassigned in
Step 3 to their respective Control Processor Module (CPM), FIM, and/or IOLIM.

Re-establish control strategy associations.

14. Flip the power switch to On, on both the primary and secondary power supply modules that are
located on the left-hand side of the chassis.

15. Load the FTE Bridge blocks. See Loading FTE Bridge block for details.

FTE Bridge blocks appear in Monitoring tab.

16. Load the rest of the blocks that make up the control strategy.

All blocks for the control strategy appear in the Monitoring tab.

17. This completes the procedure.

Resume normal operation.

6.4 Migrating from ControlNet or Ethernet supervisory network

To convert your existing ControlNet or Ethernet supervisory network to a Fault Tolerant Ethernet
supervisory network, you must make a network topology change which requires different hardware than
was originally installed with your system. This is not a software migration and requires the clean
installation of Experion software. For details about installing Experion software, refer to the Software
Installation and Upgrade Guide.

6.5 Migration from FTE based C200 to C300

You can migrate from FTE-based C200 to C300 and retain the Series A - Chassis I/O associated with
the C200 by connecting the C300 to the same FTE segment and installing an FTE Bridge module in the
Series A I/O chassis, as show in following figure.
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l Prerequisites

l Considerations

l Checking software and firmware versions

l Exporting current database and restoring clean database

l Build new C300 controllers

l Configuring control strategy

6.5.1 Prerequisites

Prerequisites

l You must take your control system offline before starting the supervisory network migration
process.

l Your current software and hardware must support at least Experion R300 software. See Checking
software and firmware versions.

l You have logged onto Control Builder with the security level required to make control strategy
changes.

6.5.2 Considerations

It may be helpful to initiate a Project Tree Charts printout through the Print command on the File menu
before you begin.

If you have a Qualification and Version Control System license, there will be additional steps required
to check out a component before you can modify it in Control Builder.
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6.5.3 Checking software and firmware versions

To check software and firmware versions

1. On the Project tab, double-click the Control Processor Module (CPM) block icon to open the block's
configuration form.

2. On the Main tab, check the Image Version (IMAGEVER) parameter to verify the current CPM
firmware personality loaded in the CPM.

3. Repeat Steps 1 and 2 to verify the Image Version (IMAGEVER) for any FIMs, IOLIMs, ACEs, or
other CPMs included in your control strategy.

4. If software and firmware versions are at the Experion R300 software level or greater, go to the next
procedure. If software and firmware versions are not at the minimum Experion R300 software level,
see the Software Installation and Upgrade Guide to install the required software and firmware.

5. This completes the procedure.

6.5.4 Exporting current database and restoring clean database

To export current database and restore clean database

1. On Monitoring tab, inactivate Control Execution Environment (CEE) and associated Control
Modules, Sequential Control Modules, and I/O Modules for all Controllers in your control strategy.
Do the same for any assigned Fieldbus Interface Modules (FIMs), links, and devices; and I/O Link
Interface Modules (IOLIM), links, and I/O Processors.

2. On Monitoring tab, delete the target C200 controllers.

3. Click the Project tab.

4. On the File menu, click Export.

5. On Export dialog, select all points and types except those for the target CPM200s.

6. To change storage directory location, click the Browse button and navigate to desired Directory
location.

7. Click the Export button. The Exporting Data dialog appears to show progress of the action.

8. With database export completed, click the Start button on the taskbar.

9. Click Programs > Experion Engineering Tools > DB Admin to open the DB Admin utility. Or - If you
are running R210 or greater software, you launch the DbAdmin utility through the Configuration
Studio. On the Configuration Explorer tab, click the Control Strategy icon and click the Administer
the control strategy database selection in the Process Control Strategies box. In this case, skip the
next Step, since you logon through Configuration Studio.

10. Logon with user name and password, if required. Click plus + sign for DBadmin folder to expand it.

11. Click plus + sign for Experion Node folder to expand it.

12. Click ERDB Admin Tasks folder to open Tasks window.

13. On Tasks window, click the Restore Database icon. Acknowledge messages.

14. When Completed successfully message appears, the clean ERDB has been restored. On Console
menu, click Exit.

15. This completes the procedure.

6.5.5 Build new C300 controllers

Build new C300 controllers with the same names as the C200 controllers they replace.
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6.5.6 Configuring control strategy

To configure control strategy

1. Configure FTE Bridge block.

2. On Project tab, configure new C300s that are associated with the FTE Bridge module to replace
those that were not exported. See the Control Building Guide for details.

3. If applicable, use the File menu New > Type > Fieldbus Device command to create any Fieldbus
device templates that were deleted when the clean database was restored. See the Fieldbus
Implementation Guide for details.

4. On the File menu, click Import.

5. Click the Browse button and navigate to directory location where you previously stored the
database and click the OK button. The database location is listed in the Directory box.

6. Ensure the check box for the Import CEE Assignments is deselected.

7. Click the Select All button.

8. Click the Import button. Track the progress of the import on the Importing Data dialog.

9. When the import is completed. Move/assign the IOMs to the applicable C300/CEEC300 block.

10. Open the IOMs one by one and assign the correct FTE Bridge to each one. Then load the IOMs.

11. Load the FTE Bridge block and other control strategy components as you normally would.

12. This completes the migration procedures.

6.6 Import/export and on-process migration support

You can use the existing Import and Export commands provided on the Control Builder File menu to
import and export a FTE Bridge block as you would any other block. The Device Index and slot number
configuration for the FTE Bridge block is exported. The base IP Address for the FTE Bridge block is not
exported, so it can be imported into a different FTE community where it will receive a new IP Address
based upon that community's base IP Address.

The FTE Bridge module supports on-process migration (OPM) in the same way as the IOLIM and FIM
modules. The on-process migration utility is a licensed option that was introduced with Experion system
R101 software. See the On-Process Migration Planning Guide for more information.

ATTENTION

l We recommend that you use the ERDB Database (or Server) Migration function of the
OPM utility to move hardware definitions like the FTE Bridge modules instead of the
Export/Import functions.

l Use the Export/Import functions to move or copy control strategies (Control Modules and
Sequential Control Modules) from one system to another.

6.7 Troubleshooting

This section lists some possible problems you may encounter in using the FTE Bridge module. The
focus is on the FTE Bridge module itself and not the FTE network which has its own diagnostics and
report mechanisms.

l FTEB module indicators are off
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l FTEB OK LED is off

l FTEB FAIL indication

l FTEB ALIV indication

l FTEB RDY indication

l FTEB BP indication

l FTEB self-test hang

l Cable error indication

l Cannot launch NTools after migration

l FTEB not visible to NTools

l Cannot create FTEB

l Cannot 'ping' FTEB

l FTE receive fault diagnostic

l FTEB test codes

6.7.1 FTEB module indicators are off

The 4-character display and all LEDs are off.

Diagnostic check The 4-character display and all LEDs are off.

Cause Module is not receiving power.

Solution
l Ensuremodule is fully seated in the chassis slot.

l Turn On power supply switch.

l Ensure power is connected to the power supply.

6.7.2 FTEB OK LED is off

The OK LED is off but 4-character display is working.

Diagnostic check TheOK LED is off but 4-character display is working.

Cause Bad LED

Solution Replace the FTE Bridgemodule.

6.7.3 FTEB FAIL indication

4-character display is alternately showing FAIL and a code number.

Diagnostic check Refer to the failure codes located in FTEB test codes.
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4-character display is alternately showing FAIL and a code number.

Cause Internal diagnostics has detected a failed application.

Solution Cycle power to the chassis. If error persists, replace the
FTE Bridgemodule.

6.7.4 FTEB ALIV indication

4-character display is showing ALIV

Diagnostic check 4-character display is showing ALIV

Cause Personality image has not been loaded to themodule.

Solution Load the personality image to theModule.

6.7.5 FTEB RDY indication

4-character display is showing RDY

Diagnostic check 4-character display is showing RDY

Cause Boot code has not been loaded to themodule.

Solution Load the boot code to themodule.

6.7.6 FTEB BP indication

4-character display is showing BP.

Diagnostic check 4-character display is showing BP.

Cause Module has not received its IP Address.

Solution
l Ensure FTE cables are connected to themodule.

l Ensure BOOTP Server service is running.

6.7.7 FTEB self-test hang

4-character display is stuck on a test code (TXXX).

Diagnostic check See the following FTE BridgeModule Test Codes table for list of
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4-character display is stuck on a test code (TXXX).

self test codes.

Cause Module has hung on self test routine.

Solution
l Cycle power to the chassis.

l If error persists, replace the FTE Bridgemodule.

6.7.8 Cable error indication

A or B LED is Red.

Diagnostic check A or B LED is Red.

Cause FTE cable is not connected.

Solution Connect FTE cable tomodule.

6.7.9 Cannot launch NTools after migration

Cannot launch NTools in Ethernet mode after migrating from ControlNet or Ethernet
supervisory network.

Diagnostic check CheckNetworkType registry key.

Cause NetworkType registry key value has not been
changed fromCNet or ENET to FTE.

Solution Change NetworkType registry key value to FTE
and re-install CDA server.

6.7.10 FTEB not visible to NTools

FTE Bridge module is not visible in NTools chassis view

Diagnostic check FTE Bridgemodule is not visible in NTools chassis view.

Cause Chassis does not contain a configured FTE Bridgemodule or
ControlNet Interfacemodule.

Solution Load configured FTE Bridge block tomodule.
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6.7.11 Cannot create FTEB

Cannot create FTE Bridge block.

Diagnostic
check

Cannot create FTE Bridge block.

Cause Invalid base IP address (0.0.0.0).

Solution Configure valid base IP address through Embedded FTE tab on
SystemPreferences dialog.

6.7.12 Cannot 'ping' FTEB

FTE Bridge module appears on System Management FTE display but cannot be
"pinged".

Diagnostic check FTE Bridgemodule appears on SystemManagement FTE
display but cannot be "pinged".

Cause Incorrect address assignment.

Solution
l Ensure DHCP server is not configured to respond to
BOOTP requests. DHCP server may assign address in
different range.

l Ensure only Honeywell BOOTP servers bundled with
Experion software are on the network.

l Change Device Index or slot number of FTE Bridge
module and retry.
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6.7.13 FTE receive fault diagnostic

The FTE Bridge has detected an open receive signal line between either of its two
Ethernet interface devices and the processor handling incoming communication.

Diagnostic
check

l The Status LED for the faulted port (A or B) on the front panel of the
FTEB turnsRED.

l The 'LAN_A' or 'LAN_B' LED for the faulted port on the FTE Tab of
the FTEB Function Block form turnsRED, respectively.

l An alarm is generated by the FTEB… "FTE Port A Receive Fault" or
"FTE Port B Receive Fault".

Cause One of the following conditionsmay result in a spurious indication of an
FTE Receive Diagnostic fault. All revolve around conditions external to
the FTEB that allow a carrier to be detected by the FTEB's Port A or Port
B Ethernet interface but eliminate FTE traffic on that port.

l Disconnecting the uplink cable of an Ethernet interface when only
one FTEB is connected to any of the downlink ports on the Ethernet
interface. In this case, the only source of external FTE Diagnostic
messages are nodes that communicate through the uplink port of the
Ethernet interface.When the uplink cable is disconnected, there are
no incoming FTE Diagnosticmessages on the FTEB. Since the
downlink cable from the Ethernet interface to the FTEB remains
attached, the FTEB has a 'good' Link Status on the port. The
combination of a good Link Status and no incoming FTE Diagnostic
messages results in the spurious indication of an FTE Receive
Fault.

l Removal and re-insertion of an Ethernet interface or power cycling
an Ethernet interface, when the associated FTEB is not power
cycled. In this case, when the Ethernet interface is re-powered, Link
Status transitions to the 'good' state long before the Ethernet
interface completes its power up and starts passing FTE Diagnostic
messages again. This interval is long enough that the FTEB's FTE
Receive Fault Diagnostic will indicate a spurious fault.

l Throttling of Ethernet traffic in the face of an abnormal amount of
communication traffic on one or both of the FTEB's Ethernet ports. In
the face of a 'storm' on the wider FTE network, the FTEB will initiate
limiting of incoming Ethernet traffic on its FTE ports. As a result of
this limiting, a sufficient number of FTE Diagnosticmessagesmay be
lost so that one or both ports see 'good' Link Status signals but no
FTE Diagnosticmessages over the sample interval of this
diagnostic. In this case, the FTEB's FTE Receive Fault Diagnostic
will indicate a spurious fault. The spurious alarm generated by the
FTE Receive Fault Diagnostic is a relativelyminor side effect, in the
case of a network storm. A network storm is signaled by other alarms
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The FTE Bridge has detected an open receive signal line between either of its two
Ethernet interface devices and the processor handling incoming communication.

in the system.

Solution Unless you suspect that one of the causes described above exists and is
resulting in a spurious indication, youmust replace the FTEBmodule
exhibiting this diagnostic at your earliest convenience.When this fault
exists, network redundancy for this node no longer is working. See
Installing FTE Bridgemodule (TC-FTEB01/TK-FTEB01) for details.

6.7.14 FTEB test codes

Test Code Function

T000 Self test start test

T001 LED check test

T002 Memc initialization test

T003 CPU mask test

ROM Test ROM Test

T010 Boot image check test

T011 Loader image check test

RAM and Parity Tests RAM and Parity Tests

T020 RAMBR or check test

T021 Lower RAMword access test

T022 Upper RAMword access test

T023 Lower RAMbyte access test

T024 Upper RAMbyte access test

T025 Lower RAMparity int. test

T026 Lower RAMparity int. test

T030 RAMparity sweep test

T031 RAM sweep time test

T032 RAM retention test
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Test Code Function

T033 RAMaddress test

T034 RAMpattern test

T040 Flash burst test

T044 RAM860 address test

T045 RAM860 pattern test

T046 CPU type test

D-Cache Tests D-Cache Tests

T050 I Cache function test

T051 I Cache integrity test

T055 D Cache function test

T056 D Cache RAMwrap test

T057 D Cache integrity test

Hardware Status Register and
System Control Tests

(The following tests look for improper
states of hardware status bits.)

Hardware Status Register and
System Control Tests

(The following tests look for improper
states of hardware status bits.)

T060 Stuckwatch dog timer pend test

T061 StuckDC fail test

T062 Stuck IRQ0 test

T063 Stuck ICP timer test

T064 Stuck ICP comm test

T065 Stuck System fail test

T066 System fail assert test

ICP ASIC and Shared RAM Tests ICP ASIC and Shared RAM Tests

T100 ICP ASIC initialization test

T101 ICP RAMbyte write test
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Test Code Function

T102 ICP RAMbyte parity test

T103 ICP RAMword read test

T104 ICP RAMbyte read test

T105 ICP RAMhalf read test

T106 ICP RAMhalf write test

T107 ICP RAMhalf align test

T108 ICP RAMword align test

T109 ICP RAMaddress test

T110 ICP RAMpattern test

T111 ICP register access test

T112 ICP address echo test

T113 ICP bus lock test

T114 ICP clock run test

T115 ICP clock compare test

T116 ICP interrupt test

T117 ICP ASIC RAMparity test

T118 ICP RAMASIC active test

ICP Tests

(The ICP comm interrupt cannot be
tested during self test.)

ICP Tests

(The ICP comm interrupt cannot be
tested during self test.)

T120 DB FPGA load test

T121 DB lower RAMbyte test

T123 DB lower RAMparity test

T125 DB lower RAMaccess test

T127 DB RAMaddress test

T128 DB RAMpattern test
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Test Code Function

FTE Bridge Tests FTE Bridge Tests

T130 DB EEPROM interface test

T131 DB PHY interface test

T150 Application image check test

T255 Self test done test
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Notices
Trademarks

Experion®, PlantScape®, SafeBrowse®, TotalPlant®, and TDC 3000® are registered trademarks of
Honeywell International, Inc.

ControlEdge™ is a trademark of Honeywell International, Inc.

OneWireless™ is a trademark of Honeywell International, Inc.

Matrikon® and MatrikonOPC™ are trademarks of Matrikon International. Matrikon International is a
business unit of Honeywell International, Inc.

Movilizer® is a registered trademark of Movilizer GmbH. Movilizer GmbH is a business unit of
Honeywell International, Inc.

Other trademarks
Microsoft and SQL Server are either registered trademarks or trademarks of Microsoft Corporation in the
United States and/or other countries.

Trademarks that appear in this document are used only to the benefit of the trademark owner, with no
intention of trademark infringement.

Third-party licenses
This product may contain or be derived from materials, including software, of third parties. The third
party materials may be subject to licenses, notices, restrictions and obligations imposed by the licensor.
The licenses, notices, restrictions and obligations, if any, may be found in the materials accompanying
the product, in the documents or files accompanying such third party materials, in a file named third_
party_licenses on the media containing the product, or at
http://www.honeywell.com/ps/thirdpartylicenses.

Documentation feedback
You can find the most up-to-date documents on the Honeywell Process Solutions support website at:
http://www.honeywellprocess.com/support

If you have comments about Honeywell Process Solutions documentation, send your feedback to:
hpsdocs@honeywell.com

Use this email address to provide feedback, or to report errors and omissions in the documentation. For
immediate help with a technical problem, contact your local Honeywell Process Solutions Customer
Contact Center (CCC) or Honeywell Technical Assistance Center (TAC).

How to report a security vulnerability
For the purpose of submission, a security vulnerability is defined as a software defect or weakness that
can be exploited to reduce the operational or security capabilities of the software.

Honeywell investigates all reports of security vulnerabilities affecting Honeywell products and services.

To report a potential security vulnerability against any Honeywell product, please follow the instructions
at:

https://www.honeywell.com/product-security

Support
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For support, contact your local Honeywell Process Solutions Customer Contact Center (CCC). To find
your local CCC visit the website, https://www.honeywellprocess.com/en-US/contact-us/customer-
support-contacts/Pages/default.aspx.

Training classes
Honeywell holds technical training classes that are taught by process control systems experts. For more
information about these classes, contact your Honeywell representative, or see
http://www.automationcollege.com.
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